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TDS TRAINING CATALOG OVERVIEW

Welcome to the gateway of excellence in employee training and development with the College of Lake County's
Talent Development Services (TDS) department. In the heart of Lake County, Illinois, TDS is dedicated to empowering
both public and private enterprises, catering to the diverse spectrum of businesses from small to Fortune 500
organizations.

COMPREHENSIVE TRAINING SOLUTIONS

TDS specializes in offering top-tier employee training, development, and coaching services tailored to meet the
unique needs of Lake County employers. Our programs are designed to elevate organizational performance, foster
growth, and drive success. Whether you're steering a small business or navigating the challenges of a large
corporation, TDS is your strategic partner for workforce enhancement.

FLEXIBLE TRAINING DELIVERY

cognhizing the dynamic nature of modern workplaces, TDS stands out by offering flexible training delivery options.
Choose from face-to-face sessions held at your location or a CLC campus, opt for virtual training modules, or embrace
a blended approach that combines the best of both worlds. TDS adapts to your preferences, ensuring a seamless
integration of learning into your organizational culture.

GLOBAL EXPERTISE AT YOUR FINGERTIPS

At TDS, we believe in the power of diverse perspectives. Our facilitators and coaches bring a wealth of international
experience, having worked and traveled around the world, delivering training across various industries. This global
perspective enriches our programs, providing your employees with insights that transcend geographical boundaries.

HOLISTIC ORGANIZATIONAL INSIGHTS

TDS goes beyond conventional training by offering comprehensive employee assessments. We help you identify pain
points and opportunities within your organization, enabling targeted interventions that yield measurable results. Our
assessments serve as a compass, guiding your business towards enhanced efficiency, productivity, and employee
satisfaction.

Contact Information
(847) 543-2887



lcon represents class that is held face-to-face or in a classroom.

lcon represents class that is held virtually via Zoom.

lcon represents the total number of contact hours in the class.

lcon represents the maximum number of participants the class is
able to accomodate.



BUSINESS GRAMMAR & PUNCTUATION

The workshop focuses on two processes: Learning the rules and developing an “eagle-eye” to catch errors!
Studies have shown that most adults rate their grammar and punctuation skills much higher than they are!
Unlike other aspects of writing, grammar and punctuation are strictly rule-based. In this workshop, you’ll
learn those rules and apply them in intensive but fun activities.

Objectives

» Identify the most common mistakes in punctuation, grammar, capitalization, spelling,
and word usage

» Apply numerous techniques to improve proofreading skills

» |dentify and use passive and active voice correctly

» Recognize misplaced modifiers and learn not to use them

» Understand how British English and American English vary in punctuation

» Use correct verb tense and avoid verb agreement errors

» Eliminate “apostrophe abuse” and “comma sprinklers”

» Understand the most typically confused adjective-adverb pairs

« Use pronouns correctly (It is never “Between you and 1...”!)

 Eliminate run-on sentences by understanding when to use a semi-colon

BUSINESS WRITING ESSENTIALS

Professionals who can write well are far more valuable to an organization than those whose business
writing is confusing and filled with errors. This intensive workshop uses proven techniques to improve
writing clarity and brevity.

Objectives

» Identify the reader’s needs and expectations to establish focus
 Organize thoughts by purpose and audience

« Get over writer’s block

 Write with greater clarity, brevity, and directness

» Use words to persuade the reader to take immediate action

. Identify and use parallelism and active voice

« Understand the components of effective email

» Identify common errors in word usage

o Establish a standard company writing format and style

o Craft letters to effectively communicate complaints, bad news, and compliments
» Improve overall readability



EFFECTIVE COMMUNICATION

Effective Communication is a powerful personal management training program that utilizes a “building-block”
technique approach, which when completed, will equip participants with the most comprehensive and applicable
interpersonal skills available. This workshop aims to develop skills in managing oneself in interpersonal situations for
more productive outcomes. Emphasis is placed on how a person becomes more effective in adapting to a variety of
situations and interpersonal styles in creative and productive ways. Participants develop skills in managing relations
by learning to take appropriate actions when relating to the four interpersonal styles concerning their interpersonal
needs, treatment of time, decision-making, and stress.

Objectives

» 360-degree SOCIAL STYLE and Versatility Assessments

» Learn to choose a productive strategy when communicating with others

» Use skills to influence the behavior of others Realize the needs, expectations, and goals of others
« Become a better observer of other’s behavior

» Understand your preferred SOCIAL STYLE of behavior and its effect on others

» Recognize the strengths and contributions of other people’s SOCIAL STYLE

« Adapt your behavior to establish relationships built on mutual goals that meet individual needs
o Identify each SOCIAL STYLE under stress

» Learn a process to reduce stress behavior

« Apply strategies for improving less-than satisfactory relationships



HOwW TO GIVE GREAT PRESENTATIONS

This one-hour session will teach you a “4-3-2” technique to help you create and present a great
speech on the spot.

Objectives

 Create well-organized, impressive five minute or less speeches using the “4-3-2” method
» Identify the components of a great speech opening and closing
» Use the basics of delivering a great speech and reduce speech anxiety

IMPROVE YOUR BUSINESS WRITING

This session will teach some techniques you can use to get others to read, understand, enjoy,
and agree with your written messages.

Objectives

» Make your documents more concise

« Make your documents more audience-centered
« Make your documents more complete

« Make your documents more correct

« Make your documents more clear



POWERFUL PRESENTATION SKILLS

This workshop is designed to give you the skills needed to deliver impactful presentations that influence people to
take action. In this workshop, you will learn to develop great presentations and present both in-person and online.
Effective public speaking can distinguish a successful professional from everyone else. Public speaking skills are
critical to individual and corporate images. Like any other behaviors, effective presentation skills can be learned and

mastered with practice.

Objectives
» Improve public speaking skills and confidence » Handle challenging questions from your audience
» Overcome stage fright « Connectto your audience to influence and leave a
» Deliver more effective, dynamic, and confidence-driven positive, lasting impression

presentations « Command aroom with a professional presence
» Create and present the most impactful PowerPoint « Beagreatimpromptu speaker

presentations » Present dynamically in both person or virtually

Eliminate poor delivery habits that detract from your
message

PRESENTATION SKILLS

Regardless of what position you hold in the workplace, effective presentation skills will not only ensure your
messages are being delivered and interpreted appropriately, but they can also set you apart from others. However, for
many professionals, the thought of presenting to an audience can be nerve- racking and unsettling. This workshop
will help you overcome the uneasiness associated with public speaking. You will walk away equipped with verbal
communication skills and effective presentation techniques that will enable you to become more confident while

speaking face-to-face and virtually.

Objectives

Identify the symptoms of stage fright and how to control its outward manifestations
Understand how platform skills compose the most viable and audible component of any
presentation.

Learn how to analyze an audience and prepare your presentation utilizing a five step
organizational method

Learn when and how to incorporate question-and-answer sessions into yourpresentations
Demonstrate the proper use andtechniques of using visual aids

Focus on presenting in a virtual setting

Three videotaped presentations

Immediate feedback from instructors and fellow attendees



RETHINKING DATA

Closing the gap between analysis and action! Organizations are facing a big problem when it comes to Data. It used to
be that we didn’t have enough. Now, it’s the opposite; we have more than we need. As a result, too many
organizations are focusing on the wrong place. Rethinking Data is an eight-hour workshop that improves leaders’
efficiency and effectiveness at making data-driven decisions. This workshop is not a number-crunching course.
Rethinking Data takes the next step, addressing the common pitfalls that preventleaders from using data to drive
decisions. The workshop is based upon Avail Advisors’ Eight Rules for Rethinking Data and is facilitated by the
founder, Brad Kolar for Business Professionals in any industry or at any level.

Objectives

» Four techniques to drive simple, clear, and actionable decisions:
1. Decision breakdown tree — quickly identifies the exact data needed to drive a decision.
2. What, why, but, and - Report status in under 3 minutes
3. Six-slide recommendation - Deliver a full recommendation in under ten minutes using just six slides (or paragraphs)
4. Decision-based reporting - Organize reports around answers rather than numbers.
« Understanding and managing the three key biases that inhibit data-driven decision making
» Quickly defining the data needed to make a decision so that you spend more time thinking about what the Data is telling
you and less time searching for it
 Turning data into actions that drive decision making
» Creating reports that provide answers rather than numbers and significantly decrease decision making time
 Creating simple, logical, fact-driven recommendations and presentations that speed up and drive audience
decision-making

Why Rethinking Data is Crucial

Presentations are littered with tables, charts, graphs, and visualizations. That is not where the value lies. The value in Data
Is not the numbers - its action. The more time you spend looking at numbers, the less time you have to act upon them.
The problem is that people don’t know what to include and what to exclude when making and communicating data-driven
decisions:

« They gather more data than they need or the wrong Data

» They build recommendations using incorrect or faulty logic

» They confuse “simple® with “superficial.”

« They leave out critical context while driving into needless detail

« They focus on numbers rather than decisions and actions

Components
Rethinking how we think - Provides an overview of how our brains process data and information.

Introduces common thinking and decision making errors/biases and shows how traditional reviewing and presenting data
contribute to those errors.

Aligning data and decisions - Focuses on honing in on the data relevant to making a decision. Improves leader efficiency by provid-
ing a structured approach to exploring data.

Turning information into action - Introduces the “Value through Information® model, which moves leaders from simply
summarizing facts and figures to telling a comprehensive data-driven story. Focuses on building an evidence-based

argument that drive decisions and actions.

Telling a data-driven story - Provides a simple template for creating a data-driven, logical, and concise recommendation or story.
Rethinking reporting - Introduces Avail Advisor’s “decision-based” reporting approach. Decision-based reporting organizes
information around answers and decisions rather than merely providing a data dump.



RETH INKING DATA(CONTINUED)

Client Success Stories

Problem: Every six months, the marketing team needed to develop its plan. They’d receive over a hundred ideas for
marketing initiatives. Meetings were long, cumbersome, and often didn’t result in a unified list. As a result, they would have
to meet several more times until they culled their list.

Solution: The team used our Decision Breakdown technique to clarify, document, and agree upon the criteria that would
be used to prioritize and select marketing initiatives. The tree ensured that every initiative was being presented and
assessed using the same criteria.

Results: The meeting prep time was reduced, the meeting itself took half the time. Going forward, Decisions
and consensus typically were reached during the first meeting and the decision making process was much

quicker.

Problem: The client was considering whether to move a currently out-sourced process back into the organization. The
process involved about $20 million in resources. She was asked to make a recommendation to the company’s COO and two

Senior Vice Presidents. She was given 30 minutes.

Solution: The manager used the business-driven story template to develop and structure her presentation.
The presentation itself took five minutes (with less than ten slides). There was a five-minute Q&A, and the
leaders made their decision.

Results: Executives made a $20 million decision in under 15 minutes (total, from the start of the presentation).
The client said she never had an executive team make a decision so quickly. One of the Senior Vice Presidents
commented that it was the best presentation he had seen in years. In particular, he noted that “She provided
more clarity and insight in five minutes than we normally get in 45 minutes to an hour.”

“Brad’s ability to cut through the noise and deliver a compelling data-driven story (without information
overload) is outstanding. His ‘Rethinking Data’ course is a refreshing take on how we present data and

highly engaging. This course has equipped me with several practical technigues to help me really focus on
the ‘action and decisions’ component of data analysis. Brad has delivered one of the best training sessions

've had. His enthusiasm for telling a great story with tangible insights from the data is inspiring.”

— National Account Manager, Fortune 100 Consumer Packaged Goods Company



SHARPENING YOUR POINT

“What are you talking about?” How often do you think that when listening to a presentation or reading an email? How
often do people think that when trying to understand you?

Organizations are awash in complexity. Often our communication contributes to that.

Complicated communication hurts decision-making and reduces organizational agility.

Sharpening your point provides tools and techniques to simplity your communication. The workshop is based on our
“Five-Second Rule”. If a person can’t get your point within five seconds or less, it’s likely to be lost.

The workshop will help you communicate simply, clearly, and directly. Our techniques can be applied across all forms
of communication (spoken, written, presented).

Objectives

» Breaking information into understandable and manageable pieces
» Simplitying ideas and messages

» Separating key points and supporting evidence

 Creating simple, easy-to-follow stories and arguments

THAT’S NOT WHAT | MEANT!

How to Improve Your Ability to Understand and Be Understooc

Project managers and leaders know that communication is vital to our success in business. You can improve

(or aggravate) almost every situation in business and life by how you communicate. The well-crafted message can
make the difference between getting sign-off or creating more resistance. It can help us influence despite limited
authority or create more obstacles to delivery.

In this highly interactive webinar, Andy Kaufman starts with the standard Sender-Receiver model and shows the
breakdowns that often happen as we try to communicate with others. Andy will help you understand the biases that
cause misunderstanding and works directly with the audience to walk through real-world scenarios to apply the
learning. This is a fun, insightful, motivating webinar that will arm your participants with practical tools to improve
their communication. If you’ve ever wondered, “How in the world couldthey think that?” you’ll benefit from this
webinar.

Objectives

o Identify key areas where breakdowns often occur with communication so they can be
avoided

 Describe biases that make it more difficult for people to understand each other

« Summarize a 5-part model from neuroscience that can help communicationbe more
effective

» Apply a 5-step process to improve their ability to be understood



TOP TEN GRAMMAR & PUNCTUATION ERRORS SEEN IN BUSINESS WRITING

This one-hour session will review the top 20 grammar and punctuation errors made in business
writing and how to avoid them.

Obijectives

» ldentify common punctuation mistakes that business writers make

o |dentify common grammar mistakes that business writers make

» Increase your awareness of the punctuation and grammar mistakes in your writing
« Use tips to remember how to avoid these common mistakes

HOW TO COMMUNICATE ASSERTIVELY NOT AGGRESSIVELY (FULL WORKSHOP)

Gain more confidence, decisiveness, and respect with assertiveness training! Assertiveness allows you to find the
balance between not speaking up and speaking up too aggressively. It is important to ask customers, colleagues,
subordinates, and superiors to meet your needs and adhere to policiesand requirements. However, this must be done
with tact and diplomacy and while remaining calm and professional.

Objectives

» Distinguish the difference between assertive, aggressive, and passive behavior

« Make a positive first impression

. |dentify and adopt the attitudes that lead to assertiveness versus passivity or
aggressiveness

» Learn to say “no” without feeling guilty and without negatively impacting relationships

« Make requests for needs to be met without others feeling imposed upon or offended

 Practice assertive behaviors through verbal, vocal, and visual techniques

« Apply newly learned assertiveness skills to relevant on-the-job situations

» Develop an assertive bill of rights

 Accept negative feedback and provide negative feedback constructively

» Expressrights, feelings, and thoughts and not blame others for being insensitive and
inconsiderate

« Learn the techniques for assertiveness



TOP TEN WAYS TO IMPROVE YOUR LISTENING

This one-hour session will teach you behaviors that will increase your ability to listen actively.

Objectives

» Understand the purpose of listening
« Use empathy, paraphrasing, encouragers, and other techniques

» Transform “problem” speakers to “problem-solving” speakers



CREATING SMART PRESENTATIONS: INTEGRATING WORD, EXCEL, POWERPOINT

Microsoft Office is known for integration capabilities. We typically work with Excel, Word and PowerPoint individually,
and we may insert data from Excel into a Word report or a PowerPoint presentation. Each program has features
specific to sharing data automatically among programs. Cathy will show you important time-saving techniques in
creating truly presentations; determine when and how to use each type of integration effectively.

Objectives

» Integrate Excel data and charts with PowerPoint

« The Many Facets of Copy, Paste

« Understand Linking vs. Embedding Data

o Link Excel data and charts with PowerPoint for automatic updating

« Master Excel data integration into Word

» Inserting an Excel Spreadsheet into Word

« Use Word to create a new PowerPoint presentation by utilizing a Word Outline.
« Use Word to create customizable PowerPoint speaker notes and handouts



EXCEL ADVANCED WITH SOPHISTICATED FORMULAS AND PIVOT TABLES

Advanced Excel course focusing on advanced formulas and Pivot Tables.

Objectives

Naming a Cell or Range of Cells

Using Named Ranges

Modifying Named Ranges

Logical Functions

Lookup Functions

Text Functions

Date Functions

Creating an Excel PivotTables

Four Sections of the Pivot Table

Adding, Removing, and Rearranging Fields in a Pivot Table
Refresh a Pivot Table

Changing the Data Source of a PivotTable

Change the Functions within the Excel Pivot Table

Change the Number Format of a Field within the Excel Pivot
Table

Add Additional Calculations to a PivotTable

Change the Calculation to a % of the Grand Total

Insert a Calculated Field

Display or Hide Grand Totals

Display or Hide Subtotals

Change Report Layout

Repeat Item Labels

Insert or Remove Blank Lines

Group Dates and Numbers

Create a Manual Grouping

Ungroup Dates, Times or a Manual Group
Display Details for a Value Field on a New Worksheet
Expand and Collapse Levels of Detail

Use Report Filters

Show Report Filter Pages for a PivotTable
Insert, Clear and Format Slicers

Create a PivotChart

Change the Chart Type in a PivotChart
Move a PivotChart

Modify a PivotChart



Objectives

Get started with Power Pivot.

« Visualize Power Pivot data.

Work with advanced functionality in Power Pivot.

Outline

Why PivotTables are the hidden gems of Excel

How to analyze large data sets from different business perspectives
Create a PivotTable to summarize data

Make understanding the data easier for others

Use PivotTables to answer questions about the data

Analyze patterns in the data

Customize the summary by grouping data

Format PivotTables for easy viewing

Use a chart to view the summary visually

Objectives

 Entering Formulas .
 Using the Sum Button .
« Orders of Operation in Excel .
» Relative VS Absolute Cell Reference in Formulas .
» Naming a Cell or Range of Cells .
» Using Named Ranges in Formulas .

Modifying Named Ranges .

EXCEL DATA ANALYSIS WITH POWERPIVOT

We are now living in the age of big data. Data is being collected all the time and for increasingly detailed transac-
tions. This can lead to an overwhelming amount of data, which brings about a need for people who can analyze large
amounts of data quickly. Fortunately, Microsoft® Excel® provides Power Pivot to help you organize, manipulate, and
report on your data in the best way possible. Since a tool is only as good as the person using it, it is important to gain
a solid understanding of Power Pivot to maximize your effectiveness when analyzing data.

EXCEL FORMULAS FROM BASIC TO ADVANCED

Excel functions can greatly increase your productivity to perform daily task. This course will cover the functions most
commonly used so you can enhance your ability to create better performing spreadsheets!

Text Functions

Date Functions

Round Functions

Logical Functions
Lookup Functions

Watch Window

Evaluate Formula Button



EXCEL FUNDAMENTALS WITH FORMULAS, FORMATTING AND PRINTING

Excel Fundamentals with Formulas, Formatting and Printing will take you from the very beginning of opening a work-
book, autofill, formatting, and finish with creating custom headers and footers. It is everything you need to know to
get started with Excel.

EXCEL INTERMEDIATE WITH TABLES, WORKSHEETS, PROTECTION AND CHARTING

Excel Intermediate with Tables, Worksheets, Protection and Charting continues where you left off with Excel Funda-
mentals with Formulas, Formatting and Printing. This workshop will expand your Excel knowledge to create tables,
rules, tables and much more.

Objectives
 Insert, delete, rename, color, move and copy worksheets

» Use conditional formatting

« Sort columns

o filter and format tables

» Createrules

» Protect workbooks and worksheets
» Convert Text data to column data

» Create subtotals

» Freezing rows and columns

« Work with charts



EXCEL: FORMULAS & FUNCTIONS

Objectives
Rules for Entering Formulas Assigning Names to Cells Financial Functions
Cell Referencing » Rules to Follow when Naming Cells « PMT Function
Order of Operations » Methods of Naming Cells « FV Function
Basic Functions - The Name Box Date and Time Functions
. . |  Entering Dates
+ Function AutoComplete Create from Selection | 5
. - The Name Manager - Serial Value
» Using AutoSum | - . .
AutoCalculat Entering Additional Functions » Today and Now Functions
utoCalculate :
l » Using the Insert Function Dialog Box Text Functions
Copying F | | .
oPYIns Formttias . Using the Formula Ribbon + Proper Function
+ Using AutoFil Statistical Functions  Left and Right Function
» Relative and Absolute Cell References . Median Function Logical Functions
3D Formula » IF Function

» Mode Function
» Selecting Worksheets Lookup and Reference Functions

Text to Columns « VLookup Function



EXCEL: LEVEL 1

Objectives
Getting Started with Microsoft Excel Moditying Worksheets Entering Excel Formulas
. The Microsoft Excel Interface » Changing Column Width ana » Rules for Entering Formulas
. Worksheet Size Row Height » Understanding the Order of
» Navigating a Worksheet » Inserting and Deleting Rows Operations
» Go to Cells Quickly and Columns » Creating Basic Calculations
. Selecting Cells » Exploring Vertical Alignment » Entering Functions
Entering Text and Numbers » Using Cut, Copy and Paste » Using Auto Sum
+ Entering Data Basic Formatting » Understanding Relative and
+ Deleting Data  Changing the Font, Font Size, Absolute
+ Editing a Cell and Font Color Cell References
« Working with Long Text » Using Bold, Italicize, and Underline » Using Autofill to Copy Formulas
. Saving a File » Aligning Cell Entries
. Customizing Excel » Formatting Numbers
. Customizing the Quick Access Toolbar » Using Borders and Shading

- Hiding and Displaying the Ribbons » Merging and Centering Headings



EXCEL: LEVEL 2

Objectives

Printing Worksheets
» Exploring Page Setup Options
» Working with Page Breaks
« Using Page Layout View
» Creating Headers and Footers
» Setting Print Options and Areas
Using Templates
» Creating Custom Templates
 Use a template to create a new
Workbook

EXCEL: LEVEL 3

Objectives
Sorting and Filtering Data

» Sorting a Single/Multiple Columns
» Filtering tor Specific Data
» Sorting/Filtering Data with
Conditional Formatting
Using Tables
» Creating and Moditying Tables
» Formatting Tables
» Sorting/Filtering Table Data
» Calculating Data in a Table
» Removing Duplicates
» Saving a File
» Customizing Excel
 Customizing the Quick Access Toolbar

» Hiding and Displaying the Ribbons

Improving Workbook Functionality
* Freezing Panes
» Applying Conditional Formatting
Working with Multiple Worksheets
» Changing the Detault Number of
Worksheets
» Inserting and Deleting Worksheets

- Formatting Worksheet Tabs

» Selecting Worksheets
» Move and Copy Worksheets

Using Subtotals
» Adding Subtotals
» Adjusting Views with Subtotals
» Removing Subtotals
Summarizing Data with PivotTables
» Creating a PivotTable
» Analyzing Data Using PivotTables

» Adding Styles Report Layouts to PivotTables

» Creating and Formatting a PivotChart
» Aligning Cell Entries

» Formatting Numbers

» Using Borders and Shading

» Merging and Centering Headings

Creating Charts

o C
o C

reating a Chart

nanging the Size and Position

of a Chart
» Changing the Chart Type

» Switching Data

» Changing the Chart Layout anc
Style

« Adding Labels

» Moving a Chart to a Chart Sheet

Working with Multiple Workbooks
» Linking to Cells in Different Work

books
» Editing Links



Excel: PIVOTTABLES

Objectives

Subtotals

» Creating Subtotals

» Adjusting Views with Subtotals
PivotTables

» Creating a PivotTable Report
Analyzing Data Using PivotTables

» Rearranging the PivotTable

« Sorting/Filtering a PivotTable
Formatting a PivotTable

» Changing a PivotTable Calculation
Summarizing Fields by Different
~unctions
Refeshing Data in PivotTable
» Refresh PivotTable Data Automatically
when Workbook Opens

Modify PivotTable Field List

« PivotTables Field List Search
Adding Records to the Source Data
Grouping Options

» Group/Ungroup Numeric

or Selected Items
» Group Dates or Times
« Rename a Default Group Name

 TImelines
PivotTable Drilldown
» Exploding the Data from a Single Cell
» Create a Separate PivotTable Reports
for Multiple Sets of Data
Conditional Formatting
Field Settings
Using Slicers

Using PivotTable Styles

» PivotTable Style Options
Custom Calculations

» PivotTable Formula Elements

» Add/Edit or Remove a Calculated

Field

» Add a Calculated Item to a Field
Additional Tools: Subtotals, Grand
Totals, Report Layouts - Compact,
Tabular and Outline Analyze
Ribbon

« PivotTable Group

 Show/Hide Group
« Actions Group
Creating a PivotChart
» Creating a PivotChart or a
Standalone PivotChart
« Chart Drilldown



EXCEL: POWERPIVOT

Upon successful completion of this course, you will be able to use PowerPivot along with Excel to analyze
data from a variety of sources.

Prerequisites

To ensure your success in this course, you should have experience working with Excel 2016 and PivotTables.
You should already understand spreadsheet concepts and be comfortable creating and analyzing basic PivotTables.

Objectives

» Work with advanced functionality

» Get started with PowerPivot  Visualize PowerPivot data
In PowerPivot

Outline

Getting Started with PowerPivot Visualizing Data Working with Advanced Functionality
» Enable and Navigate PowerPivot « Create PowerPivot Report « Create a Key Performance Indicator
» Manage Data Relationships » Create Calculations in « Work with Dates and Time in

PowerPivot PowerPIvot



EXCEL: SUMMARIZING & ANALYZING EXCEL DATAWITH PIVOT TABLES

This informative training session, you’ll learn how to use PivotTables better to sort, filter and subtotal your data more
efficiently.

PivotTables can help you sort and sift through large data sets to focus quickly on just the data elements that matter
most to your specific needs. In addition, you’ll get tips on the easiest way to group your data. Most importantly, when
you use the power of PivotTables, you’ll be saving time and making your job easier.

Objectives

 Better sort, filter and subtotal your data more efficiently
» Create multiple customized reports in a few easy steps
» Gain a powerful new tool to help you make better business decisions

Outline

« Why PivotTables are the hidden gems of Excel

« How to analyze large data sets from different business perspectives
« Create a PivotTable to summarize data

« Make understanding the data easier for others

« Use PivotTables to answer questions about the data

« Analyze patterns in the data

» Customize the summary by grouping data

» Format PivotTables for easy viewing

« Use a chart to view the summary visually



Objectives

» Customizing Excel
» Navigating a Large Workbook

» Selecting with Shift and CTRL
e Freezing Rows and Columns

Objectives

» Perfecting Formulas: Function
Library/Autocomplete

» Using 3D Formulas

» Calculating with Dates and Times

EXCEL: TIPS & TRICKS —

EXCEL: TIPS & TRICKS —

LEVEL 1

» Splitting a Worksheet

» Using Page Layout View for
Headers & Footers

» Sorting and Filtering

LEVEL 2

« Naming Cells
o |F Statements
« VLookup Formulas

» Subtotaling
 Using Table Functionality
» Perfecting Basic Formulas

 Charting Data

 Analyzing Data with PivotTables

« Apply Enhanced Conditional
Formatting



EXCEL: PROGRAMMING WITH VBA

Visual Basic for Applications or VBA refers to the development environment that is built into the Microsoft Office suite
of products. By using the Visual Basic programming language, VBA allows you to create custom functionality and au-
tomate task in Office applications like Word and Excel. In this course participants will learn how to use the Visual Basic
programming language and various Excel objects to write code that can control Excel.

Requirements
Each participant should provide their own computer with a minimum of Microsoft Office 2016 installed.

Objectives

« Record and edit macros » Use intrinsic functions

» Use the Visual Basic Editor » Work with control-of-flow structures

» Create sub and function procedures » Design UserForms and work with controls

« Understand objects, properties, methods and « Control PivotTables programmatically
events » Use debugging tools

 Explore the Excel object hierarchy and use the «Add error handling to code

Object Browser

« Work with variables and understand data types



INFRASTRUCTURE, SOFTWARE, & COMMUNICATION SERVICES

What does your Business Need?

Consultative services

. General technology assessment
. Security Gap analysis

. Cyber Insurance readiness review
. CyDer Security awareness training
+ Email services

Managed email - Microsoft 365 or Google Workspace
. Inbound & outbound message filtering

. Secure email

.« Computer services

Endpoint Protect ion
. System backup

. File folder backup
.+ Network services

Network firewall & remote access

. Local network discovery and vulnerab ility scanning
. External network vulnerability scanning

. Website hosting

. Productivity services

Microsoft Office Applications
. File sharing - e.g. Dropbox

. Secure cloud Tile systems

. VOIP phone services



MICROSOFT: POWER Bl

As a business intelligence tool, Power Bl offers the team excellent visual analytics capabilities. With the right
data and platform, it can be an excellent fit for in your efforts to use data to boost efficiency and productivity
within an organization. However, we always encourage how essential it is to experiment with different tools
before committing (i.e., purchasing) licenses or long-term contracts.

Requirements

» Each participant should provide their own computer with a minimum 2-cores and 4GB RAM running one of the
following versions of Windows: Windows 8 / Windows Server 2008 R2, or later.

» Participants must signup for Power Bl and download Microsoft Power Bl Desktop

» Participants must have an internet connection (WiFi or wired)

Objectives

Power Bl Desktop

» Accessing Data
» Adding additional data
« Data Preparation

» Renaming tables

« Filling empty values

« Renaming columns

 Using Column from Examples to split columns

MICROSOFT TEAMS

Objectives

Navigate the Teams interface
Find and join a team

Manage a team

Create a team

Add members to a team

Change team settings

Add a channel

Customize channel notifications
Work with channels

View team and channel analytics
Send a message to a channel
Create a channel announcement
Format text

Reply to a message

Removing unwanted rows Power Bl Service

 Transposing data » Publishing Report

« Appending queries e Building Dashboard

» Data Modeling and Exploration » Collaboration and Distribution
« Layout

 Data Exploration - Slicers, Charts, Cards
« Data Visualization

o Attach files  Set a status message

« Create a new chat « Understand the Activity feed
« Work with chats ¢ Use @mentions

« Make a call from a chat « Use commands

» Answer a call « Use keyboard shortcuts

« Manage call settings

« Schedule a meeting

» Join a meeting

» Change you video background
« Share contentin a meeting

» Use a whiteboard

» Record a meeting

» Take meeting notes

« Schedule a live event



MICROSOFT WINDOWS

Microsoft Windows provides the basic knowledge needed to use and perform basic configuration of a computer run-
ning Windows; this includes basic operating system features, using and installing apps, managing files and common

external devices, using network connections and applications, configuring system settings, and personalizing Win-
dows environment and privacy features.

You will benefit most from this course if you are the primary user of a Windows computer and wish to become profi-
cient with its features, but are not yet a power user or computer technician.

This course assumes you are familiar with using a keyboard and mouse, accessing the internet with a web browser,
and other basic aspects of using a modern computer. It does not assume you have used earlier editions of Windows or
other specific operating systems, or that you have owned or managed a computer before.

Outline

Chapter 1: Getting started
Module A: Windows 10 highlights
Module B: Setting up Windows 10

Module C: Navigating the interface
Chapter 2: Managing apps
Module A: Using apps

Module B: Installing apps

Chapter 3: Files and devices
Module A: Managing files

Module B: Folders and locations

Module C: Common devices
Chapter 4: Internet features
Module A: Web browsers

Module B: Internet and cloud apps

Module C: Network connections
Chapter 5: Computer management
Module A: Windows settings

Module B: Accounts and security

Module C: Updates and maintenance

Chapter 6: Personalization

Module A: Personalizing the Windows environment

Moaule B: Privacy settings



ONENOTE - MADE EASY

Objectives

Troubleshoot SharePoint errors
Insert meeting details

Insert a symbol

Search for notes

Keyboard shortcuts

Apply a background color to the current page
Protect notes with a password
Sync notebooks

Share notebooks

Convert and solve a math equation
Insert a table

Insert an online video

Edit a picture

Insert a picture from a file

Add links

Insert a check box

Set paragraph alignment
Delete, cut, and copy text
Select text

Draw precise shapes
Create a new ink pen
Print notes

Record audio notes
Convert handwriting to text
Move and resize notes
Type a note

Reorder pages

Add more pages

Add more sections
Create a new notebook



ONENOTE - SMART & EFFECTIVE NOTETAKING

OneNote is a digital note-taking app that provides a single place for keeping all of your notes, research, plans, and in-
formation — everything you need to remember and manage in your life at home, at work, or at school.

In OneNote, notebooks never run out of paper. Notes are easy to organize, print, and share, and you can search and
find important information quickly, even if you forget where you've originally captured it. Best of all, your notebooks
are stored online so you can easily get to them on any of your mobile devices.

Objectives

« Notebooks vs Tabs vs Pages in OneNote
« Saving OneNote to the OneDrive
» Share notebooks

 Using the Quick Notes Section

» Organizing Your Notebook

« Use Page Templates

» Inserting a Graphic

 Insert Tables

o Insert Screenshots

» Copying Text from a Picture

» Inserting an Equation or Symbol
« Using Tags ie Insert a check box
» Recording an Audio or Video Clip



OUTLOOK & WORD: TIPS & TRICKS

Outline

Outlook 2016 Tips and Tricks Word 2016 Tips and Tricks

- Use Quick Steps to Automate Repetitive Actions - Use the Quick Access Toolbar

- Assign Categories to Emails - Hide the Ribbons

- Use the Favorites Folder - Show Hidden Characters

- Create Search Folders to Provide a View of All Email Items - Zoom in with CTRL/mouse wheel
Matching Specitic Criteria - Change the Dertault Font and Font Size

- Automate Signatures - Use “Tell Me What You Want To Do”

- Use and Create Outlook Templates - Navigate a Long Document

- Create an Autotext Entry for Quick Replies - Select Data Quickly

- Increase the Font Size While Reading Mail in Outlook - Double click to type anywhere

- Display Emails as Conversations - Delete Words with One Key Press

- Schedule Delivery of An Email and Other Email Options - Use Find and the Navigation Pane

- Manage Incoming Mail Alerts - Search for Edited Words

- Automatically File an Incoming Email - Clear All Formatting

- Save An Email as A PDF File - Replace Invisible Characters and Formatting

- Drag and Drop an Email to Create A Contact - Find Word’s Hiaden Calculator

- Rely on Natural Phrases to Create A Calendar Event - Create Hyperlinks

- Go To a Specitic Date Quickly - Look Up a Worc

- Save Important Emails, Calendar Events, And Notes as Files on Your - Create Your Own AutoCorrect Settings
Desktop. - Copy Multiple Items at One Time

- Rely on Sticky Notes for Quick Reminders. - Drag and Drop

- Learn Your Keyboard Shortcuts! - Wrap Text around Pictures

- Highlight a Square Area of Text
- Sorta List

- Insert Symbols

- Insert the Date and Time

- Work with Page Breaks
- Know Your Keyboard Shortcuts



OUTLOOK EMAILING AND CALENDARING TECHNIQUES

If you use Outlook, you know how useful its calendar is for scheduling appointments and meetings. But there’s more
to the calendar and emails than you might think. This workshop will help you become more efficient and organized in
your daily work.

Objectives

OUTLOOK: TIPS & TRICKS

Navigate the platforms
Create desktop alerts

Send email at a particular time
Create contacts from email
Create and work with folders
Use quick steps

Display calendar dates
Create multiple views

Create quick appointments
Export calendar to Excel
Create Contact groups

Objectives

» OQutlook 2016 Tips and Tricks

» Use Quick Steps to Automate
Repetitive Actions

» Assign Categories to Emails

 Use the Favorites Folder

» Create Search Folders to Provide a
View of All Email Items Matching
Specific Criteria

» Automate Signatures

» Use and Create Outlook Templates

» Create an Autotext Entry for
Quick Replies

» Increase the Font Size while
Reading Mail in Outlook

» Display Emails as Conversations

» Schedule Delivery of an Email
and Other Email Options

« Managing Incoming Mail Alerts

» Automatically File Incoming Mail

 Save and Email as a PDF file

 Drag and Drop an Email to Create
a Contact
 Rely on Natural Phrases to Create
a Calendar Event
 Go to a Specific Date Quickly
» Save Important Emails, Calendar
Events and Notes as Files on your
Desktop
» Rely on Sticky Notes for Quick Reminders
» Keyboard Shortcuts



POWERPOINT: LEVEL 1

Objectives

Getting Started with Microsoft PowerPoint

» The PowerPoint 2016 Interface
 Customizing the Quick Access Toolbar
PowerPoint Views

» PowerPoint Terminology

- Slide Navigation

Creating Effective Presentations

» Creating and Starting New Presentations
» Entering Text

» Inserting and Deleting Slides

» Rearranging Slides

» Saving Files

» Changing Layouts

POWERPOINT: LEVEL 2

Objectives

Adding Tables

» Creating and Formatting a Table

» Modifying the Table Structure

e Adjusting Column Width and Row Height
» Merge and Split Cells

Adding Charts

e Creating a Chart

» Modifying Chart Data

« Customizing a Chart

e Inserting a Chart from Excel 2010-2016
Customizing a Presentation

e Setting up a Slide Show

e Setting up a Custom Show

Working with Designh Themes

« Applying a Theme

Working with Presentation Elements

e Inserting Pictures and Online Pictures

» Sizing and Moving Objects

« Enhancing Pictures

« Drawing Shapes

» Selecting Multiple Objects

« Formatting Shapes

 Ordering, Aligning and Grouping Images
Formatting Text

» Methods for Selecting Text and
Placeholders

» Working with Font and Paragraph Attributes

Reusing Slides from Other
Presentations and Working with

the Slide Master

» Modifying the Slide Master

» Adding and Deleting Layouts

» Modifying the Placement/Format of the
Date, Footer, and Slide Numbers

e Inserting Headers and Footers

» Saving a Custom Theme and Template
« Examining the Handout and Notes
Masters

Running the Slideshow

 Presenter View

» Pen and Highlighter Tools

» Slideshow Tools

Preparing to Deliver a Presentation
» Adding Transitions and Animations
Running the Slideshow

» Options to Begin the Slideshow

« Navigating through Slides

Printing and Layout Options

Hyperlinks

» Adding a Link to a File or Website
e Linking to Other Slides in the Pre-
sentation

» Modifying a Hyperlink

Creating SmartArt Diagrams

» Inserting Diagrams

» Modifying Illustrations

» Formatting SmartArt

 Convert Bulleted Text into
SmartArt

Using Animation

Adding Sound and Movies



POWERPOINT: TIPS & TRICKS

Objectives

 Learning New Slide Shortcuts  Cropping Pictures

» Re-using Slides from Other Presentations » Creating SmartArt Diagrams
 Arranging Slides in Slide Sorter view » Inserting Hyperlinks

» Using Built-in Templates e Linking Charts from Excel

» Modifying Themes  Using the Animation Painter

e Inserting Pictures and Screenshots » Reordering Animation

 Using Speaker Notes

» Annotating a Presentation
» Creating Custom Shows

e Setting up a Slide Show



SAFE SOCIAL MEDIA FOR SMALL BUSINESSES

Business owners need to balance social media presence with remaining safe from cyber threats. The workshop will

help owners protect themselves and their business from social media’s dark side.

Objectives

Learn about biggest social media platforms currently out there and how you can use them to your organization’s advantage
Why we use social media, and the benefits and risks involved with expanding your online presence to improve your business
The biggest threats that cyber-criminals are currently using to compromise your accounts, your pages, and your business
How to engage with consumers without sharing too much information with potential cybercriminals on your pages

How to properly monitor your network and social media accounts



SAFEGUARDING YOUR BUSINESS FROM CYBER HREATS

Is your business safe from cyber-attacks? Cyber-attacks are at an all-time high and every business is at risk. Any size
business is vulnerable, no-one is too small or too big. Putting anti-virus on your computer is not sufficient. Learn 4

steps to a more secure business-technology environment.

Objectives

Learn the 4 steps needed to protect your client and corporate data
ldentify risk your business faces

Know what data are you responsible for protecting

Understand where are your most vulnerable data

Perform a risk assessment

ldentify email attacks

Choose the tools needed to protect your business



SHAREPOINT: OWNERS

Microsoft® SharePoint® 2016 is a platform designed to facilitate collaboration and allow people to use familiar
applications and web-based tools to create, access, store, and track documents and data in a central location. As
such, SharePoint has many distinct features that must be enabled and configured, and many content structures that
can be selected, added, and configured. In this course, you will learn how to create, configure, and manage a
SharePoint team site so that your team or organization can share information and collaborate effectively.

This course is designed for existing Microsoft SharePoint site users who need to create and manage a SharePoint
team sit

Outline

Lesson 1: Creating and Configuring a New Site
¢+ |0
e |0
Lesson 2: Adding and Configuring Libraries
e |0
e [0
» Topic C: Configure a Content Approval Process

DIC A: Create a New Site

nic B: Configure the Look and Feel of Your Site

nic A: Configure a Document Library

nic B: Configure Document Versioning and Check Out

Lesson 3: Adding and Configuring Lists

O
O

¢+ |0
Lesson 4: Creating Custom Lists and Forms

nic A: Add and Configure an Announcements List

nic B: Add and Configure a Tasks List

nic C: Create, Contigure, and Integrate Contacts and Calendars

« Topic A: Create and Conftigure Custom Lists

 Topic B: Create Custom List Forms

Lesson 5: Assigning Permissions and Access Rights

O
O

nic A: Share Sites and Set Site Permissions

nic B: Secure Lists, Libraries, and Documents

Lesson 6: Extending SharePoint Functionality with Web Parts
e [0
« [0

vic A: Add and Contfigure Included Web Parts

nic B: Add and Configure External Web Parts



SHAREPOINT: USERS

In many professional environments today, people work collaboratively in teams. Information technology and
applications facilitate this by allowing people to easily share, access, edit, and save information. Microsoft®
SharePoint® 2016 is a platform specifically designed to facilitate collaboration, allowing people to use familiar
applications and Web-based tools to create, access, store, and track documents and data in a central location. In this
course, you will learn about and use a SharePoint Team Site to access, store, and share information and documents.

Who Should Attend

Users who are transitioning to a SharePoint environment, and who need to access information from and collaborate
with team members on a Microsoft SharePoint Team Site

Outline

Lesson 1: Interacting with SharePoint Team Sites

» Access SharePoint Sites

» Navigate SharePoint Sites

Lesson 2: Working with Documents, Content, and Libraries
 Upload Documents

« Search for Documents and Content

Lesson 3: Interacting in SharePoint

« Update and Share Your Profile

» Follow and Share Content

Lesson 4: Working with Lists

« Add and Modity List Iltems

» Configure List Views

« Filter and Group Data with List Views

Lesson 5: Integrating with Microsoft Office

« Access and Save Microsoft Office Documents with SharePoint
« Manage Document Versions

« Work with SharePoint Data from Outlook



STREAMLINING TECHNOLOGY FOR YOUR BUSINESSES

Many small businesses treat technology as an afterthought. In this session you will learn how to be more efficient,
secure and effective with software and services designed for SMBs. We will cover business communications, website
and ecommerce solutions, business tools and general IT services.

Outline

Business Communication Business Management

.+ Email » Bundled Subscriptions (365, Google Workspace, Zoho)
» Voice » Perpetual Licenses

¢ SMS  Accounting Options

 Chat » Customer Relationship Management
» Social Channels » Quoting & Invoicing Tools

Website Functions « Collecting Payments

. All sites » Agreements & Signatures

 Brochure Sites » Inventory & Subscription Management
» Expanded Site Information Technology

» Client Portals » Computing

» eCommerce » Networking

eCommerce Considerations » Data Security

 [axes

» Shipping

+ Documents & Reporting



WORD: LEVEL 1

Objectives

Getting Started with Microsoft Word

» The Word 2016 Interface

» Default Settings

» Changing Default Settings

« Add Tools to the Quick Access Toolbar
Reviewing a Document

» Spelling and Grammar Checker

» Setting Spelling and Grammar Options
» Using Autocorrect

» Using the Thesaurus

» Using Find and Replace

Formatting Text

« Working with Fonts

 Using Format Painter

» Using Line Spacing, Indents, and Alighment

WORD: LEVEL 2

Objectives

Creating Basic Tables

e Inserting a Table

« Add/Delete Columns and Rows

» Change Column Width and Row Height
» Merge Cells

Adding Graphic Objects

 Adding Clipart and Photographs

» Moving and Resizing Objects

« Wrapping Text Around Objects

» Inserting Page Borders

Working with Text

« Typing Text with Wrap

« Show/Hide Formatting Marks
 Saving a File

e File Types

» Navigating a Document

» Selecting Text

e Inserting and Deleting Text
 Using Undo and Redo

» Using Cut, Copy and Paste

» Copy and Paste with Keyboard Shortcuts
« Hiding White Space

Creating Newspaper Columns

 Sections

« Add and Balance Columns in a document
» Control Column and Gutter width

e Inserting Column Breaks

Managing Lists

» Sorting a List

« Re-Number a list

« Multilevel Lists

e Creating AutoText

Adding Items to a Word Document
» Using Bullets and Numbering

« Adding Symbols

e Inserting the Date and Time

» Creating Labels and Envelopes
Printing Documents

» Using Print Preview

 Exploring Page Setup Options

e Inserting Page Breaks

» Printing a Document

Styles

» Using Built-In Styles

e Creating Custom Styles

» Using Custom Styles

» Modifying Styles

» Using the Navigation Panel



WORD: TIPS & TRICKS

Objectives

« Use the Quick Access Toolbar

e Hide the Ribbons

« Show Hidden Characters

« Zoom in with Ctrl/Mouse Wheel

» Change the Default Font and Size

« Use “Tell Me What You Want to Do”
» Navigate a Long Document

» Select Data Quickly

» Double Click to Type Anywhere
 Delete Words with One Key Press

 Use Find and the Navigation Pane

» Search for Edited Words

o Clear All Formatting

 Replace Invisible Characters and
Formatting

 Find Word’s Hidden Calculator

» Create Hyperlinks

« Lookup a Word

» Create your Own AutoCorrect Settings
» Copy Multiple Items at the same time

« Drag and Drop

« Wrap Text around Graphics
 Highlight a Square Area of Text
 Sort a List

e Insert Symbols

e Insert the Time and Date

« Work with Page Breaks

« Know your Keyboard Shortcuts



VIRTUAL POWER COURSES (60-90 MINUTES)

Enjoy efficient workshops in a live webinar format ranging in timelengths

Excel PivotTables for Real Estate Appraisers

Excel: PivotTables to Analyze the MLS for Real Estate Agents and Appraisers - Part 2
Excel: Tips and Tricks for Real Estate Agents and Appraisers

Excel: Consolidating and Linking Data in Excel Workbooks

Excel: Exploring Conditional Formatting and Data Validation

Excel: Recording Macros with an Introduction to VBA

Excel: Understanding Excel's Basic Formulas

Excel: Visualizing Excel Data with SmartArt and Charts

Excel: VLOOKUP, MATCH, and INDEX

Outlook: Ten Really Cool Features to Boost Efficiency

Excel: Analyzing Data with Excel Pivot Tables

Excel: Managing and Analyzing Data with Excel Tables to Excel: Using Tables to Manage Excel Databases
Excel: Mastering Charts

Excel: Top Ten Essential Functions

Excel: Working with Excel DataBases - Sort, Filter, Subtotals & More

PowerPoint: Delivering Successful Presentations

Word: Working with Large Word Documents

60 minutes
60 minutes
60 minutes
60 minutes
60 minutes
60 minutes
60 minutes
60 minutes
60 minutes
60 minutes
75 minutes
75 minutes
75 minutes
90 minutes
90 minutes
90 minutes

90 minutes



BUILDING TRUST IN THE WORKPLACE

According to most recent Gallup Study, 85% of employees are actively disengaged at work. The number one driver of
employee engagement is the trust level that they feel with their direct manager. You cannot address disengagement
issues without first addressing trust. A transparent culture of learning and development helps create this trust. This
workshop will give you essential tools to be transparent in your decision-making by gaining maximum involvement in

a way that inspires trust.

Objectives

360-Degree SOCIAL STYLE and Versatility Assessments

ldentify areas of concern you have and how to facilitate a productive outcome
The Life Cycle of Growth Ability Model

Learn the R3 Process

Implement the Dynamic Communication Process

Differences between high and low trust behaviors and the impact of both

The 4 Cores of Credibility

The 13 behaviors of high-trust leaders



CHANGE MANAGEMENT

Every day, we are faced with differences in opinions, ideas, values, needs, expectations, styles, behaviors, and
interests. Each of these differences has the potential for raising a conflict. Conflict can also be attributed to the excess
amount of stressors impacting the workplace. Building conflict management skills among teams are important to
maintaining a healthy and comfortable work environment. This interactive course provides an opportunity to
identify the various sources of conflict within your organization. We then explore conflict management styles and
develop your team’s skills to effectively manage those sources.

Obijectives

» Understanding the Circle of Influence/Circle of Concern Change Model

» Understanding the elements of change

» Understanding how the four dominant styles of behavior handle change
« Team Life Cycle

¢ Team Assessments

 Creation of a Personal Change Action Plan



CREATING A POSITIVE, MOTIVATING ENVIRONMENT

Loyal, engaged employees produce better business results. Studies show that organizations with highly
engaged employees have higher profit margins, greater customer loyalty, and better shareholder value than
those whose engagement scores are low. In an employee engagement study conducted in low-turnover
organizationsin 2012, Gallup found that turnover was 65% lower in highly engaged groups versus groups
with low engagement.

Objectives
« Understand morale versus motivation » Learn the importance of extrinsic versus intrinsic motivations
 Improve productivity for you and your direct reports » Become better team players by collaborating more effectively
e Increase trust, openness, and approachability « Understand how employee values impact motivation
» Increase employee commitment, engagement, and energy and resistance
- Identify employee motivators and strategize ways to build - Give feedback in a way that motivates behavior

upon them « Motivate the motivated

- Identify de-motivators and consider strategies to eliminate or » Generate an action plan to implement new behaviors
minimize them immediately
« Understand why people do what they do
 Appreciate what a manager can do to improve motivation and
morale



DEVELOPING EXECUTIVE PRESENCE: LEAD & DELIVER

In this fast-paced, highly interactive course, Andy Kaufman shares practical insights gleaned from years of working
with executives around the world. He builds on the idea that executive presence is based on confidence without ar-
rogance. But what about those daunting moments when you don't feel so confident? Through interviews with senior
leaders and leading authors and experts, Andy shows how the imposter syndrome is an issue we all struggle with,
from aspiring frontline leaders to CEOs (and shares practical ideas on how to address it).

From how we show up, speak up, and deliver results, executive presence is not something we innately have or not--it
Is something you can develop. This fun, insightful, motivating keynote shows you how.

Objectives

» Define what executive presence is and what must exist for us to trust a leader

» Explain what needs to be in place for people to willingly follow a leader

» Describe what the imposter syndrome is and how to recognize it when they are falling into it

« Explain why many leaders need to increase their assertiveness in order to improve their effectiveness
« Apply the learning to daunting, real world scenarios



DYNAMIC LEADERSHIP WORKSHOP

The workplace today is characterized by constantly changing dynamics. As a result, the workplace and our personal
lives have become more behaviorally, educationally, and culturally diverse. Recognizing and developing individual
diversity (both at home and in our working environments) is critical to individual effectiveness and organizational and
personal productivity. Versatile and responsive leadership and the development of others are imperative for a suc-
cessful future. This dynamic workshop will introduce tools and strategies to improve your versatility and provide you
with practical skills that will help you foster strong relationships, build trust, manage stress and tension, and
encourage and guide others.

Objectives

» 360° SOCIAL STYLES and Versatility Assessment
» Understanding and adapting your SOCIAL STYLE
» Managing Styles and Conflict

» The Dynamic Developments Leadership Model
 Setting Performance Goals and Objectives
 Providing Positive and Developmental Feedback
» Performance Analysis and Coaching

» Measuring Team Effectiveness

» Developing a High-Performance Team

 Stress Management Strategies Employee Engagement
 Building Trust

o Effective Communication

» One-on-One follow-up Coaching Sessions



EFFECTIVE INTERVIEWING & HIRING

With the costs of recruitment, salary, benefits, training, and time invested in hiring a new employee, we can’t afford to
hire just any candidate — we have to hire the right candidate! This course will help you gain new insights for building
the right team to allow you to lead and be a successful organization.

Objectives

» Gaininsights and practices for preinterview preparation

» Develop job-related questions to assess

 Past performance and comply with equal opportunity employment laws

» Identify key competencies for success in the position

» Practice behavioral-based interviewing Evaluate the information and make quality hiring decisions
o Strategies for identifying high versatility behaviors

EFFECTIVE MEETING MANAGEMENT

Recent surveys have indicated that in the last five years the amount of time we spend in

meetings has risen. These surveys have made it apparent that people feel meetings are unproductive and result in a
waste of time and resources. This results in longer working hours for everyone involved in the meetings. We will
cover the essentials of facilitating effective in-person or virtual meetings, including how to structure the meeting,
create a meaningful agenda, and set rules and expectations. This session will provide participants with practical
tools to increase the effectiveness and productivity of meetings and encourage team camaraderie and increase
productivity.

Objectives

» Assess the effectiveness of your meetings

» Learn to plan and organize meetings to maximize productivity

» Learn to encourage participation - turn passive participants into active participants

 Discover how to conduct meetings to enable you to keep discussions and decision-making on track
» Learn how to increase your effectiveness as a meeting participant

o |dentify helpful roles while planning and conducting meetings

» Learn to apply meeting management skills

e Q&A Guidelines

» Meeting Follow-up

o Facilitating Virtual & In-Person Meetings



EFFECTIVE TIME MANAGEMENT

In this workshop, we present a fundamentally different approach to time management. This interactive session will
show you ways to manage your time more effectively, focus on activities that yield the greatest results, and organize,
prioritize and execute around your goals. During the workshop, participants explore the principles and pitfalls that
govern professional and personal efficiency and effectiveness. Through exercises, guided discussion, and a little in-
trospection, participants make their way through a valuable journey toward fulfilling their personal and professional
performance capabilities.

Objectives

» Examine the importance of working both efficiently and effectively

 Assess their competency in managing time/self effectively

« Use the “time management matrix” tool to determine how they use their time

 Practice a time/self-management process that balances effectiveness and efficiency

 Discover and apply practical tools and techniques to manage tasks, others, and self resulting in
increased productivity, and decreased stress.

» Develop a 30-day commitment plan to apply these new concepts of time/selfmanagement in their
professional and personal lives.



EMPLOYEE ENGAGEMENT

Versatility is a strong predictor of job performance and is comparable to intelligence, education, and personality. This
course will share how one can improve their versatility, as well as provide you with practical skills that will help you
foster strong relationships, build trust, and encourage and guide others. Leaders play a significant role in influencing
employees’ level of engagement. Higher engagement leads to greater productivity, customer loyalty, and employee
retention. This course will help you understand how to motivate employees, starting with understanding your
preferred leadership style and how to better understand the preferences and tendencies of your team members.
Upon completing this course, you will have the practical tools you need to increase engagement and promote an
inclusive environment within your team.

Objectives

» The Life Cycle of Growth Ability Model Learn the R3 Process for more productive interactions

« Learn how to use The Dynamic Developments Communication Process to provide useful,
developmental, and impactful feedback for all behavioral styles and ability levels

« Assessing your team members’ behavior styles and how to adapt your style accordingly

» Managing Styles and Conflict

 Providing Positive and Developmental Feedback

» One-on-One Follow-Up Coaching Sessions



GENERATIONAL DIVERSITY

The past years have brought a cascade of social media movements addressing ethnic diversity, gender diversity, and

iIncome diversity.

Fortunately, progress is being made to close these gaps.

However, there is a new kind of diversity that only 8% of US companies even recognize.
It is called, “diverse generations on teams.”

They are:

. The Builder Generation (1929-1945)

. The Baby Boomer Generation (1946-1964)

.+ The Baby Buster Generation or Gen X (1965-1982)

. The Millennial Generation (1983-2000)

. The Generation Z (2001-2015)

For the first time in history, up to five generations find themselves working alongside one another in a typical com-
pany. The result? There can be collisions. Interactions among people from different generations can resemble a

cross-cultural relationship.

Objectives

» Erathey were born

o Life Paradigm or Narrative

o Attitude to Authority

» Market

» How each generation can benefit from each other

» Making the different generations on your team a competitive advantage



How TO: TEAM DEVELOPMENT/BUILDING

Relationships are the key to the success of any organization. The more we know about ourselves and others, the
better we can avoid pitfalls, leverage our strengths, and move to new levels of team effectiveness. To function as a
high-performance team, all members must know and appreciate the strengths and needs of the other team

members.

Our interpersonal styles influence the way we plan and organize our work, communicate, and make decisions. In
addition, people tend to behave differently in groups than they do as individuals. Along with the effect our
interpersonal styles have on a team effort, the interactions among the various members’ styles become major factors
in a team’s success or failure. This program will allow you to identify, explore, and discuss the effects of individual

interpersonal styles on your team.

Objectives

» Identify the elements and characteristics of a High-Performance Team
» Discover how teams develop

« Describe the behavior in terms of its relationship to Team Effectiveness
» Learn how to improve Teamwork

» Define your Work Team Balance Sheet

« Measure Team Effectiveness

» Develop a Team Work Action Plan



LEADERSHIP FAST TRACK PROGRAM

Every organization has them. People who are high potentials — those that show the promise of having an
even greater influence on the job. Or people in leadership roles need someone to partner with to help them
be even more effective. The Leadership Fast Track Program is designed for business professionals who want
to accelerate their ability to lead their teams, influence others, and deliver results. We will turbocharge your
ability to lead with confidence, take focused action, and achieve the results you desire.

Overview

 Leadership program designed for high-performers and high-potentials
 Classroom or Virtual program
» Customize scheduling to fit your needs

Objectives

» Develop and prepare leaders for even greater levels of influence

 Implement practical tips & tools to lead, build relationships, and influence others in all generations
» Develop leadership capabilities that deliver results

« Apply techniques to manage time, commitments, and engagement

 Learn how to effectively handle conflicts

Workshops

The Leadership Fast Track Program can be customized to include some or all of the below.

» Essentials of Leadership » Developing Your Team

 Developing Relationships  Developing Leaders

 Developing your Influence » Making Better Decisions for you, your team, and your projects
» Managing Your Time and Commitments e Program Wrap-Up

» Dealing with Conflict
» Leading Successful Projects
 Improving Your Ability to Understand and be Understood



LEADING TEAMS THAT DELIVER

Our success in delivering results often depends on how effectively we collaborate. Yet getting a team of people to
truly work in partnership can be a daunting challenge. We’re left with the tension: we need our teams to be high
performing yet teams are made up of people with varying degrees of knowledge, skills, and commitment. We need
our teams focused on delivering a goal, but sometimes egos, personalities, and agendas get in the way. In this highly
interactive keynote, Andy Kaufman asks you to think back to one of the best teams you’ve been a part of in your
career thus far. What made it so exceptional? Andy also shares a model that helps you diagnose what’s going well
with your team and factors holding back team effectiveness. How does your team deal with conflict? Do you see gaps
in levels of commitment and trust? Are you looking to better motivate and engage your team? In this keynote, Andy
shares practical ideas to help your team move forward in its ability to deliver successful results.

Objectives

» Explain how team leaders are responsible for more than just delivering results: we must also maximize potential.

» Describe a 5-part team model and use it to identify where their team can focus to improve results.

» Describe the difference between cognitive and affective conflict, and why the distinction is critical for high-performing teams.
» Summarize specific strategies to improve their team’s ability to lead and deliver.

 Explain specific strategies to engage their team.



LEADING UNDER PRESSURE

Leading today is not for the faint of heart. Most professionals are faced with more work to do than they have time or
resources to do it. Most of us face the daily burdens of leading in a stressful and often thankless environment. Yet your
roles are so critical! How can you hang in there when burnout seems inevitable? In this session, author and execu-
tive coach Andy Kaufman relates lessons learned from interviewing many of today's top experts on leadership. Andy
shares why your ability to thrive starts with taking care of yourself. Andy will share an innovative, evidence-based
perspective on stress that can help during times of pressure. And he will explain one of the most important and over-

looked strategies to help you and your teams when the pressure is on.

Objectives
« Explain why, in times of challenge, sleep, exercise, and diet directly impact our effectiveness under pressure.

» Describe practical strategies to manage interruptions and conflicting priorities.
» Implement practical skills for building relationships, regardless of whether someone is more introverted or extraverted.

» Describe strategies for how to keep from becoming a victim during challenging times.
» Apply evidenced-based approaches to develop a disposition of gratitude.



MANAGING VIRTUAL TEAMS

Virtual teams can outperform groups that are co-located! To succeed, however, virtual collaboration must be
managed in specific ways.

Overview

 ldentify the unique competencies needed of virtual leaders « Communicate effectively across time zones

« Understand the challenges and advantages of virtual teams « Develop trustin virtual teams

« Apply best practices to build and maintain relationships and » Choose the best technology to support
rapport within virtual teams virtual relationships

« Manage performance and relationship challenges from a » Develop effective skills for facilitating team meetings in a virtual
distance environment

MEETING MANAGEMENT

Managing a meeting requires sound planning, effective organizing, making preparations for disruptions, minute- tak-
ing, preparing the meeting place, and managing the attendees. The meeting facilitator is a catalyst, coach, coordi-
nator, and more. Like a conductor, the meeting facilitator must bring out the best in individual players and orches-
trate successful group efforts. When meetings are effectively run, people are engaged and can generate collaboration,
trust, deliverables, commitment, and actions that lead to the desired outcome.

Overview

» Understand the benefits and costs of meetings—know whento « Chair meetings effectively by dealing with disruptions and
have a meeting and when not to professionally handling personality differences

» Identify components of effective and ineffective meetings o Start the meeting with the right tone and make ground rules

» Focus on efficiency and results, keeping the purpose in mind work
throughout the meeting » Identify roles in the meeting to increase efficiency

» Organize both the content and process » Keep the meeting focused and on track and get closure on each

» Make phone and webinar meetings more effective agenda item

» Gaininsight into choosing the right time & place based on » Facilitate discussions to get participant involvement, show
meeting type, attendees & necessary outcomes support, resolve conflict, manage differences and make

» Understand the importance of using all five steps of effective decisions
meetings: Planning, starting, focusing, facilitating, and » Conclude by identifying unfinished business and completing
concluding next step action plans

» Plan and adhere to an agenda » Ensureinformal, and ad hoc meetings are effective and efficient



PROJECT PLANNING & DELEGATING

As the success of a business rises, so does the increase in project workload. However, organizations do not always
have skilled project managers to handle the demand. This engaging course will help develop the practical skills
necessary to successfully lead a team toward setting and achieving goals and deadlines. Leaders will improve their
versatility by acknowledging and adapting to the different ability levels and behavioral styles of each team member.
The ability to effectively delegate and empower your teams are essential to successful leadership and will increase
productivity and improve individual and team morale. Additionally, strong communication is a necessary component
for any team, and we will share a communication process that is sure to provide structure and enhance efficiency.

Objectives

» 360-Degree SOCIAL STYLE and Versatility Assessments

» The Dynamic Developments Critical Thinking and Communication Process

» The R3 Interaction Process

» Choosing the right team members for the project

« The Dynamic Developments Leadership Model

 Learn the difference between delegating and “dumping”

» Assess the abilities of team members to determine who and who not to delegate to

» Learn how to delegate properly by understanding the SOCIAL STYLE of your team
members

» How to delegate to ensure the best organizational outcome



RETHINKING RESULTS

“What are you talking about?” How often do you think that when listening to a presentation or reading an email? How
often do people think that when trying to understand you?

Sharpening your point provides tools and techniques to simplify your communication. The workshop is based on our
“Five-Second Rule”. If a person can’t get your point within five seconds or less, it’s likely to be lost.

The workshop will help your team communicate simply, clearly, and directly. Our techniques can be applied across all
forms of communication (spoken, written, presented)

Workshop delivered of two days.

Objectives

» Breaking information into understandable and manageable pieces
« Simplifying ideas and messages

« Separating key points and supporting evidence

 Creating simple, easy-to-follow stories and arguments



TEAM DEVELOPMENT

Relationships are the key to the success of any organization. The more we know about ourselves and others, the
better we can avoid pitfalls, leverage our strengths, and move to new levels of team effectiveness. To function as a
high-performance team, all members must know and appreciate the strengths and needs of the other team mem-
bers. Our interpersonal styles influence the way we plan and organize our work, communicate, and make decisions.
In addition, people tend to behave differently in groups than they do as individuals. Along with the effect our inter-
personal styles have on a team effort, the interactions among the various members’ styles become major factorsin a
team’s success or failure. This program will allow you to identify, explore, and discuss the effects of individual inter-
personal styles on your team.

Objectives

o |Identify the elements and characteristics of a High-Performance Team
« Discover how teams develop

» Describe the behavior in terms of its relationship to Team Effectiveness
« Learn how to improve Teamwork

» Define your Work Team Balance Sheet

» Measure Team Effectiveness

» Develop a Team Work Action Plan

THE DIRTY LITTLE SECRET OF BUSINESS: IT’S ALL ABOUT RELATIONSHIPS

In this webinar, Andy Kaufman shares “The Dirty Little Secret of Business.” You won’t learn this secret in school, yet it
Is critical to your success. The secret is simple—it’s all about relationships. Andy describes the key relationships you
must develop to advance your projects and career. Discover how understanding different personality types will im-
prove your ability to build rapport, influence people, and control situations. Learn what networking is—and isn’t—and
how to increase your networks’ effectiveness with less effort.

Participants of this webinar will know how to answer the questions: How can you deal with difficult people who are
obstacles to your ability to deliver? How can you influence someone to align with your priorities even when you don’t
have the organizational authority? How can you find time to network when you’re overwhelmed with day-to-day
work?

Objectives

» Explain how relationship-building is critical to our careers, regardless of personality type

» Describe the difference between an “inner circle” and a “got to group”, and why both groups are necessary for your success
« Implement practical skills to develop relationships in their company, industry, and beyond

» Describe ways to leverage social media as part of an overall relationship-building strategy



THE EFFECTIVE ADMINISTRATIVE ASSISTANT SERIES

Are you looking for ways to revitalize your work and find a fresh perspective on all that has to be done?

This program will provide you the fundamental tools required for you to be successful. The program is an
instructor-led online course to help administrative professionals deliver results in the real world. You will gather
online with other assistants for a series of two-hour, highly interactive sessions. By participating online, you minimize
your time away from the office.

Great workshop for any administrative Professionals, administrative assistants, executive assistants, office managers,
event planners, and receptionist

Objectives

« Communications skills, including listening, questioning and being more assertive

» How to increase your effectiveness in recognizing and managing conflict, as well as dealing with difficult people
« How to influence others even when you don't have authority over them

« How your personality style works to your favor (and might work against you)

 Afive-step model for getting things done with less stress

» Easy-to-use templates and tools to successfully deliver projects

 Practical approaches to juggle all that's on your plate



THE FIVE APPROACHES TO MANAGING CONFLICT

Whenever two or more people come together, there is bound to be conflict.Each of us learned early in life how to
handle conflict. Some face conflictas a collaborative problem-solving opportunity. For some of us, it may be that we
learned to handle conflict by being aggressive, and by protectingour egos. This Conflict Resolution Workshop offers
conflict resolution skills and techniques to build stronger organizations and more rewarding relationships.

Objectives

» Understand what conflict is and what conflict » Identify your own feelings and actions in response to
resolution is conflict

» Understand the five approaches to conflict resolution: » Distinguish between listening for thoughts and listen-
collaborating, competing, compromising, ing

accommodating, avoiding for feelings

 Neutralize emotions and set ground rules » Learn how relationship conflict and content conflict
« Choose the best time and place are handled differently

» Create mutual understanding  Develop a strategy for handling passive or aggressive
» Recognize the underlying causes of conflict behavior

» Practice applying models, techniques and strategies  Decrease defensiveness in self and others

to manage communication behaviors in conflict « Apply win-win negotiating methods

situations » Promote cooperation with co-workers

» Explore barriers to conflict management and resolution » Identify how your perception of situations impacts

your reactions

THE IMPORTANCE OF UNDERSTANDING THE TWENTY REASONS PEOPLE
DON’T DO WHAT YOU WANT THEM TO DO

his one-hour session will review 20 reasons why your employees, co-workers, and managers don’t do what you want
them to do. Cooperation is an essential tool.




TOP EIGHT SKILLS THAT ALL MANAGERS NEED

This one-hour session will review the eight skills categories that all managers should develop and the specific skills
In each category.

Objectives

- Identify leadership skills that you need to develop

» Identify interpersonal skills that you need to develop

» Identify oral and written communication skills that you need to develop

- [dentify technical and organizational knowledge that you need to develop
- Identify personal development skills you need to develop

» Identify administrative skills you need to develop

TOP TEN CHARACTERISTICS OF SUCCESSFUL LEADERS

This one-hour session will teach the essential characteristics that a business leader must develop to
create followers.

Overview

» Leadership program designed for high-performers and high-potentials
 Classroom or Virtual program
» Customize scheduling to fit your needs

TOP TEN TIPS TO CONDUCT EFFECTIVE MEETINGS

This one-hour session will teach the essential rules to have a virtual and in-person meeting, which are
productive and positive.

Objectives

» Plan great meetings

 Begin a meeting correctly

- Facilitate meeting to stay on time, to manage discussions, and to get results
» Receive feedback of “That meeting was a good use of my time”



TOP TEN WAYS TO KEEP YOURSELF AND YOUR STAFF POSITIVE

This session will teach the components to keep ourselves and our team positive—especially during tough times.

Objectives

» Identify the ways individuals differ in terms of staying positive

» Recognize the importance of listening to both the content and emotion
» Increase feelings of control and security in self and others

» Assess value differences and adapt to differences in others

VIRTUAL LEADERSHIP

Technology offers the flexibility for employees to work from the office or remotely. As the amount of remote employ-
ees increases, so do the challenges that leaders face when managing virtual teams. In this course, you will discover
the behavioral styles of your team members and how that influences the way we organize our work, communicate,
and make decisions. Strategies for engaging and motivating team members virtually will be shared, along with tips
for navigating technology and the various virtual platforms.

Obijectives

» The Life Cycle of Growth Ability Model

« The R3 Process for more productive virtual interactions

« Learn how to use The Dynamic

» Developments Communication process to provide useful, developmental, and impactful virtual
feedback for all behavioral styles and ability levels.

« Assessing your team members’ virtual behavior style and how to adapt your style accordingly

» Managing Styles and Conflict

 Learn strategies for interpreting nonverbal communication in a virtual setting



BUSINESS ETIQUETTE

Creating a professional, mutually respectful atmosphere enhances communication in the workplace. This course is
designed for professionals looking to sharpen their business etiquette skills, addressing topics such as appropriate
business attire, making a good first impression, understanding cultural communication differences, crafting business
emails, and practicing good virtual etiquette. From sending an email, or mastering your elevator pitch, to attending a
formal company banquette, you will leave this course equipped to handle various situations that arise in the
workplace.

Objectives

» Appreciate the importance of professional image

« Analyze written communication to create a positive business impact
» Review proper etiquette in social/business settings

» Assess your personal and professional style

« Understanding subject, greeting, and signature etiquette

» Proper practices during a phone call

 Practices in text message content



CALMING THE STORM: HOW TO DEAL LOGICALLY WITH CUSTOMER EMOTION

It customers feel a service was not superior, they might not only stop being your customers, they might even take ac-
tions to negatively impact your business with future customers! In fact, on average, disappointed customers discuss
their negative experiences with at least 9 people. And if posted on social media, that impact grows greatly and can be
devastating.

Ironically, these bad experiences can actually be good news: It's a moment of truth to solidify the customer relation-
ship. That is, research supports most "satisfied" customers don't evolve into "wowed" customers until something
goes wrong and you handle it smoothly!

In this four-hour workshop, you will learn practical steps to deal with customer anger, frustration and even
belligerence that results in satistying both you and your customer.

Objectives

» Stay calm, respectful, empathetic and constructive when confronted by frustration, disappointment and anger
 Listen to both content and emotion

« Apply empathy and the Platinum Rule

 Avoid certain words and behaviors which can worsen the situation

» Gain customer trust

« Calm customer emotions as you focus on what you want

« Decrease defensiveness in yourself and the customer

« Modify nonverbal behavior and learn to say "no" to customers so that the relationship stays positive

« Turn problem-making customers into collaborative problem-solving customers



CONFLICT RESOLUTION

Every day, we are faced with differences in opinions, ideas, values, needs, expectations, styles, behaviors, and
interests. Each of these differences has the potential for raising a conflict. Conflict can also be attributed to the excess
amount of stressors impacting the workplace. Building conflict management skills among teams are important to
maintaining a healthy and comfortable work environment. This interactive course provides an opportunity to
identify the various sources of conflict within your organization. We then explore conflict management styles and
develop your team’s skills to effectively manage those sources.

Objectives

» Identify points of tension and conflict among your team

« Discover how to use tension as a positive motivator

« SOCIAL STYLE /Versatility Assessment

o Identify each SOCIAL STYLE under stress

» Learn a process to reduce defensive fight and flight behaviors

« Apply strategies for improving less-than-satisfactory relationships
« Dynamic Developments Communication Process

CRITICAL THINKING AND PROBLEM-SOLVING: THE KEY TO EFFECTIVE
DECISION MAKING

Critical thinking is the act of analyzing facts, beliefs and assumptions to understand a problem or topic thoroughly.
This workshop teaches how to observe and gather information, ask thoughtful questions and analyze possible
solutions.

Objectives

« Understand the essential components of critical thinking and the ideal characteristics of critical thinkers
 Discover a decision-making process that creatively solves problems

 Dissolve the biases and assumptions that affect your ability to think rationally

« Understand the importance of gathering factual information and being open-minded

 Avoid being trapped by “logical fallacies”

« Discover ways to become more inquisitive and analytical

« Overcome obstacles to thinking critically



EMOTIONAL INTELLIGENCE (EQ)

Emotional intelligence includes four parts: self-awareness, self-regulation, empathy, and relationship-building.
Someone with high Emotional Intelligence can identify and regulate their emotions as well as effectively identify the

emotions of others. We will walk through the steps to developing and increasing your emotional intelligence which
will ultimately allow you to build better relationships, reduce team stress and tension, alleviate conflict, and improve

productivity. The goal of this course is to provide you with the practical knowledge and skillset necessary to identity
and understand the emotions of others.

Objectives

» Learn the core elements of Emotional Intelligence
» Develop self-awareness and self-management of personal emotions

« SOCIAL STYLE assessment
« Become a better observer of other’s behavior Understand your preferred SOCIAL STYLE of

behavior and its effect on others



GREEN BELT
Why do you need Green Belts?

A Green Belt knows how to fix slow, inflexible, defective, obscure, costly, and risky operations.
Our graduates learn not only Six Sigma but also Lean and Deming principles for excellence.
Together, these methods teach how to solve problems and stay on top of change.

Our instructor-coaches have worked in Lean Six Sigma programs with IBM, PepsiCo, Johnson & Johnson,
Shell, and many medium-sized companies.

This program is designed for anyone who must solve problems at work or past participants of Lean Six
Sigma workshops.

Overview

o Certification in as short as one week - you don’t have time to waste

» No-nonsense statistics that work where you work - the real world

« Freedom from exam retake fees - we’re with you if you need a couple of tries
« 97% certification success rate

» 900 certified Lean Six Sigma Green Belts through 2017

» 9.7/10 participant satisfaction rating since 2009

 Particpants MUST supply their own laptop PC with MS Excel 2010 or newer

Prerequisites

 Excel cut/paste formulas, using multiple sheets (basic to intermediate)
« Workplace experience - More than 1-year of professional work experience

Objectives

» The Green Belt body of knowledge in a form that is immediately useful at work
« How to spot and solve problems in teams and individually
» Project management, meeting facilitation, and oral communication skills

Workshops
» Study the Lean Six Sigma body of knowledge at the Green Belt « Highly experiential - blend of lecture with hands-on work 40/60
level (LSSGB) « Each participant solves a unique problem in the company case
 Get certified - participants may earn the LSSGB certificate (sales, finance, production, field service)
granted by the Six Sigma Masters program o Instructors and coaches are certified Lean Six Sigma experts who

« Earnyour “belt” by completing a standard project report in class, enjoy teaching
not just by passing an exam



KEEPING YOURSELF POSITIVE AND MOTIVATED

In this one-day workshop you will learn ways to be positive about the past, the present and the future and to be
motivated and to be fully engaged and productive in the future. You will identify what you value the most in your
personal life and professional life and learn to take actions so that you are living those values. In addition, you will
learn techniques to manage your stress and respond to negative people.

Objectives

» Understand the components of being positive, » Explore the challenges and solutions of staying
motivated, and productive positive and goal-oriented

- Identify what you can control and change » Recognize the underlying causes of stress and

« Obtain new insights into your work attitudes and demotivation

values « Manage your negative stress levels

» Set personal and professional goals based on these e Interact with others to create positive relationships
values « Handle negative people and resist being dragged down

» Select actions to achieve your goals » Problem-solve to move forward



NEGOTIATION & CONSULTATIVE SELLING

In today’s competitive selling environment, businesses no longer require a “customer vendor” relationship, but
rather a strategic relationship with a “business partner”. Winning in today’s environment requires the ability to
continually negotiate with clients, vendors, and colleagues in a way that builds and strengthens relationships. This
workshop aims to help sales professionals develop skills to manage themselves in sales situations for more
productive outcomes. Emphasis is placed on how a person becomes more effective in adapting to a variety of
situations in creative and productive ways. Participants develop skills in managing relationships, using a systematic
approach to build ongoing, value-added relationships with their clients, and how to effectively relay their message to
any type of communication style.

Objectives

» Differentiate between utilizing a “process” vs. “product” sales approach
« How to be perceived by the client organization as an “added valued” partner

)

» Demonstrate the use of the “Five I’'s” questioning model

» Develop implied needs into explicit needs

» Describe the components of the client agreement

« Demonstrate a benefit-oriented solution

« Demonstrate how to handle client objections and concerns
 Define different types of objections Describe how to gain closure
« Describe the characteristics of a professional recommendation

» Theory and stages of negotiation

» Understanding the difference between positions and interests



NETWORKING SKILLS

This workshop aims to help professionals prepare and thrive at networking events. Networking events, whether
virtual or in- person, are a key aspect of furthering a person’s career. These events help people build connections that
can lead to the next job, the newest customer, or the newest mentor. This workshop will give you skills to present
yourself in a professional, but friendly way, and help you prepare to best represent yourself to anyone you come in
contact with.

Objectives

» How to prepare for a networking event

» How to have quality and meaningful conversations
» What to do during the networking event

« How to follow up after the event



SIX STRATEGIES FOR DEALING WITH DIFFICULT STAKEHOLDERS

Have you ever lost sleep because of a difficult stakeholder? Maybe it was a boss, peer, or someone on

the other side of the business. Perhaps it was worry about dealing with them in an upcoming meeting or
ruminating about how they are an obstacle to progress on a project. In this session, Andy Kaufman shares six
strategies for dealing with difficult stakeholders. There are no simple answers, but these are strategies that
Andy has shared with clients worldwide, and you’re invited to see which ones you can put into place. After
all, you deserve a better night of sleep!

Objectives

» Describe more broadly what a stakeholder is and how managing their expectations is so critical
to project success.

 Explain the difference between “keeping stakeholders informed” and “keeping them satisfied.”

» Describe practical strategies to help deal with and influence difficult stakeholders.



STRESS MANAGEMENT

There are excess amounts of stressors currently impacting the workplace. This course takes a unique approach to
stress management. There are times when we experience positive, productive tension, however; when it crosses the
line and makes us unproductive, that is the definition of stress, and there is nothing positive about stress. We

will begin with introducing the behavioral styles, then dive deeper into what happens to each of these styles when
they are under stress. In this course, we will discuss processes for reducing stress, relaxation techniques, and a
strategy for improving unsatisfactory relationships, all to ensure employees can bring their best selves

to work every day.

Objectives

» Identify points of tension and stress among your team

 Using tension as a positive motivator 360- Degree SOCIAL STYLE and Versatility Assessment
» Identify each SOCIAL STYLE under stress Learn a process to reduce defensive fight behavior
 Learn a process to reduce defensive flight behavior

» Apply strategies for improving less-thansatisfactory relationships

« Dynamic Developments Communication Process

TIME MANAGEMENT

Time management is self-management. Learn what you need to do to be more productive in less time and
with less stress.

Objectives

« Plan and prioritize each day’s activities in a more efficient, « Learnto say “no” diplomatically
productive manner » Minimize the impact of distractions

» Use technology to be more efficient « Ensure meetings are efficient

« Overcome procrastination

 Organize your workspace and workflow
» Delegate more efficiently

 Eliminate time wasters



TOP TEN TIPS TO MANAGE YOUR TIME

This one hour session will teach techniques that are a foundation of superior time management.

Objectives

 Prioritize tasks

« Overcome procrastination

« Decrease distractions and interruptions

« Say “no” diplomatically

» Make meeting more efficient and productive

TOP TEN WAYS TO IMPROVE YOUR CRITICAL THINKING SKILLS

This one-hour session will teach you what you need to focus on to increase your critical thinking.

Objectives
» Recognize the importance of being curious and asking » Use logic and avoid “logical fallacies”
great questions » Challenge your perceptions

« Adopt a creative, problem-solving approach
» Distinguish between facts and opinion
« Use experts



WE DON'T HAVE ENOUGH TIME

One of the most consistent concerns expressed to us by professionals and teams around the world is this: We don’t
have enough time! The stress of having too much to do and not enough time to do it is overwhelming. In this
interactive webinar, Andy Kaufman shares practical lessons to help you get a better handle on what it takes to more
successfully manage your time and commitments. Topics include understanding the role of taking care of yourself
(including getting more sleep and exercise), factors that drive procrastination (and strategies to overcome them that
will help you manage your time and projects), ways to say No without saying "No", and strategies to manage
Interruptions.

Objectives

« Explain how sleep, exercise, and diet directly impact their ability to better manage their time and commitments

« Describe research-based strategies to battle procrastination

« Implement practical skills to stay focused on their top priorities

» Describe strategies to say “No” to commitments they should not be making, even when there’s social pressure to say “Yes”



YELLOW BELT

Yellow Belt certification with a master coach A Yellow Belt is an effective associate who brings problem- solving skills
to any team. Work at all levels is challenged daily by problems that make it slow, inflexible, defective, hard to
supervise. At the same time, associates at all levels want to and must do a good job. This course gives your associates
the best concepts and tools to solve problems and sustain excellence every day. Our instructor-coaches have worked
in Lean Six Sigma programs with IBM, Pepsico, Johnson & Johnson, Shell, and many medium-sized companies.

Overview

» Experience a one-of-a-kind learning method

» Case-based teaching brings the most realistic experience possible for the classroom

» Custom courses include on-site activities with participants’ current challenges

 Particpants MUST supply their own laptop PC with MS Excel 2010 or newer

Objectives

» The Yellow Belt body of knowledge in a form that is immediately useful at work

« How to spot and solve problems in teams and individually
 Daily meeting facilitation and presentation skills

Workshops

Understanding the Operation (Day 1)

Basics of Lean

Cost of Poor Quality

Operational Problems

Voice of the Customer

Voice of the Process - data collection
Quality Tools

Understanding Data

Basics of Six Sigma

Understanding Variation

Stabilizing the Operation (Day 2)

Learning from the Gemba

Seeing the Waste in the Work

5S

Poka-Yoke

Visual Management

Cellular Work

Guided Innovation - SCAMPER, Kata
Standard Operating Procedures
Monitoring and Responding to Variation



LEAN SIX SIGMA SHORT CERTIFICATE COURSES

The new short certificate courses were created to reduce a significant commitment of time or money.

Any of these courses and tracks will equip the participants with a new vision of their work, roadmap for
improvement, and tools immediately useful in their workplaces. As an extra benefit, completing any of these
tracks counts towards earning a Green Belt certification.

Getting Smart with Numbers

BEYOND ZERO DEFECTS MANAGING VARIATION NUMBERS THAT MATTER

This half-day session focuses on
the questions: Is there anything
wrong with seeking to have zero
defects? What is the impact of

This full-day session focuses

on the questions: What does it
mean when a metric is higher or
lower than last week? Can you

This full-day session focuses on
the questions: How do you know
what to measure? By what
method? How frequently,

producing to meet tell whether a change is precisely?
specifications? significant?
Objectives Objectives Objectives

« Define defect, defective, and the cost of  Differentiate between random variation

o |dentify KPlIs

being in-spec and a signal to action  Define data collection plans

« Target setting and variation reduction to « Control charts 2

« Learnto see the data and interpret the

reduce costs meaning of any changes

Managing Daily Work Easier

LETTING THE WORK FLOW PRODUCTIVE WORKSPACES VISUAL WORKSPACES

This full-day session focuses on
the questions: What gets in the
way of smooth, fast, defect-free

This full-day session focuses on
the questions: Are you enabled
or hampered by your workspace?

This half-day session focuses on
the questions: Can you immedi-
ately see and understand your

work? How many of our efforts
are wasteful?

Objectives

o |dentify non-value-adding tasks

 Surface wasteful practices: the Hidden
Factory or Hidden Office

« Challenge “the way it’s always been

done”

Can you find what you need to
work on? Quickly? How much
walking is productive? Are any

work areas less safe than they
should be?

Objectives

« Conduct Gemba walks

« Chart motion with Spaghetti diagrams

« Analyze value-added, non-value- added
work

« Redesign your workspace: 5S, cellular

work

operation? Are issues on the sur-
face or buried deep down? How
to accelerate feedback? Are you
able to show desired behaviors
and performance?

Objectives

« Display daily performance to support im
provement

 Jidoka

« Feedback flows and action

« Reduce the number of meetings



Working as a Team

MAPPING WORK FLOW OUR WORK END-TO-END WINNING AS A TEAM
This full-day session focuses on This full-day session focuses on This half-day session focuses on
the questions: Do you know how the questions: Do you know how the questions: What happens
the work is done? When is the the work is done? When is the when we let bad products go by?
last time you walked along with last time you walked along with May the customer suffer? May
a document or part? Which a document or part? Which our teams suffer too?
procedures are cumbersome, procedures are cumbersome,
frustrating? frustrating?
Objectives Objectives Objectives
« Create a common picture of the work  Calculate first-time productivity « The operation as an integrated system
« SIPOC « Learn the five hidden costs of poor « Define accountability in a systemic way
« Map processes and uncover challenges quality » Learnthe “3 Nevers” of teambuilding

(bottlenecks, handoffs, delays) « Process efficiency and quality.

. RACI

Working Better and Faster

IMPROVING THE WORK MEASURING WORK RESULTS SOLVING PROBLEMS IN

EVERYDAY OPERATIONS

This full-day session focuses , ,
. This full-day session focuses on
on the questions: Who do we work ,
the questions: What should we

for, and which results are
do when we spot a problem?

. Important? What is the ,
urgent? How to improve oper- . . Escalate or take action? How do
relationship between results,
we learn more about our

ations and personnel perfor- .
. processes, and inputs? ,
mance? Will small changes make operations every day?

a difference?

This full-day session focuses on
the questions: Where to start im-
proving when everything seems

Objectives Objectives Objectives

. Ask ‘why’ not ‘who’ + Voice of the customer . Managing feedback loops

« Key performance indicators

e Ask ‘why’5 times « Match responsibility with the

» Learn how to get started by making small + Input, process, and output variables information
changes: Kaizen, Kata  Data collection planning and execution . Jidoka
. Error prevention: Poka-yoke + Data visualization and Pareto charts » Winin small increments: PDSA

Standard work « Run charts and trends



BRIDGING THE GENERATIONAL GAP: EFFECTIVE COMMUNICATION
AND MANAGEMENT

In today's diverse workplace, effective communication and management across different generations are essential
for fostering collaboration, boosting productivity, and creating a harmonious work environment. This dynamic and
interactive workshop is designed to help your organization bridge generational gaps while incorporating the powerful
insights of SOCIAL STYLES to enhance interpersonal interactions. By the end of this engaging workshop, participants
will be equipped with the knowledge and skills needed to navigate generational differences with confidence, foster-
ing a more harmonious and productive work environment.

Outline

1. Understanding Generational Differences:
a. Explore the unique characteristics, values, and communication preferences of each generation, from Baby Boomers to Gen Z.

b. Discover how generational differences can impact teamwork, leadership, and organizational culture.

2. SOCIAL STYLES Assessment:
a. Participants will undergo the SOCIAL STYLES assessment to identity their communication and behavioral tendencies.

(short self-assessment)
b. Gain insights into your own SOCIAL STYLE and how it influences your interactions with colleagues from different generations.

3. Effective Communication Strategies:
a. Learn practical techniques to adapt your communication style to connect with individuals from various generations anc

SOCIAL STYLES.
b. Develop active listening skills and empathy to build stronger relationships and resolve conflicts.
4. Multigenerational Leadership:
a. Explore strategies for effective leadership that transcend generational boundaries.
b. Foster an inclusive leadership approach that leverages the strengths of each generation and motivates team members.




ESSENTIALS PROJECT MANAGEMENT

Delivering projects on time, on budget, with the desired scope is no small order. Today’s business
environment demands more to be done with less. The pressure to deliver without slipping schedules

or over-spending continues to grow. This learning session provides participants the essentials they

need to identify and practice standard project management skills and techniques. Based on the Project
Management Institute’s Project Management Body of Knowledge (PMBOK® Guide), this interactive session
will use exercises and small group activities to ensure participants leave with a practical understanding of
project management’s essentials.

This workshop is designed for Project Managers & Leads, Business Analysts, Team Leaders, Project Team
Members, and Stakeholders.

Objectives
» Identify key factors that lead to project success » Identify techniques to provide better estimates for projects
(and failure) » Describe strategies for managing changes that inevitably occur
« Describe the Project Management Institute’s 5 Project with projects
Management Processes and the type of activities that occur « Describe the critical path and how to use it to manage
within them a project successfully
 Facilitate a work breakdown structure exercise on » Apply the following structured approach for managing risks:
a real-world project risk identification, qualitative risk analysis, risk response
» Describe techniques to influence project stakeholders, planning
even when they don’t have authority over them » Describe how to draw out lessons learned at the end of a project
Outline
Key Project Management Concepts Work Breakdown Structure
» Whatis a project? - Why develop a WBS?
« Why do projects fail? - Practical techniques for racilitating WBS sessions
» Rolling wave planning Estimation Techniques
 Thetriple constraint - Concepts to improve estimating
People and Projects - Qverview of estimation technigues
» Key insights into leading teams and managing stakeholder Critical Path
relationships. - Whatitis and why it matters
Initiating a Project - Practical examples of how to use critical path to deliver
» Aligning projects to business needs Risk Management
» Developing a project charter - Risks and projects
» Understanding project stakeholders - Practical techniques to identify and plan for risks
Planning a Project Closing
« The payback of planning (without going into analysis-paralysis) - Practical tips for closing a project and drawing out lessons learnec

» Developing a scope statement
» Defining success criteria



ADVANCED PROJECT MANAGEMENT

Delivering projects on time, on budget, with the desired scope is no small order. Statistically speaking, the
odds are not in our favor. Yet, the margin for error has all but disappeared in most organizations. We have to
deliver.

The Institute’s Advanced Project Management Workshop is a combination of nuts-and-bolts theory and
practical lessons learned, all packaged in a fast-paced, highly interactive session to get your organization on
track to deliver successful projects consistently.

This workshop was designed for project managers & leads, Business Analysts, Team Leaders & Members,
Stakeholders, and those aspiring to get their PMP Certification.

Objectives

« Analyze which projects should be selected over others, helping to ensure the right projects are worked on
» Describe the importance of identifying & analyzing stakeholders to manage expectations

- Identify the standard practices for project cost management, including earned value analysis

 Describe the practices to build quality management into projects

» Identify the key practices involved in project procurement management

- Identify the appropriate conflict-handling style for the situation to manage project conflict better
 Describe methods to improve accountability and influence skills among project team members

« Apply negotiating skills to typical project situations

Outline
Project Selection Methods Procurement Management
» Project litecycle vs. Product litecycle » Best practices for project procurement management
« Benefit measurements methods, such as Weighted Scoring » Applying those practices in your organization
Model, Beneftit-Cost Ratio (BCR), and Cash Flow Analysis Techniques « Contract types and concepts
Stakeholder Analysis Managing Conflict
» The importance of thoroughly identitying stakeholders « Sources of conflict on projects
» Approaches to analyzing stakeholders to manage their » Conftlict handling modes & techniques
expectations better. Accountability & Influence
» Dealing with stakeholders who are obstacles « Techniques to improve accountability and influence on teams
Cost Management Negotiating Skills
» Technigues to estimate project costs. « Stages of negotiating
» Best practices for project cost budgeting » Hands-on negotiating exercise

+ Earned value management principles and formulas
» Hands-on exercises to develop skills with earned value principles
Quality Management
« The importance of prevention over the inspection and other
key quality lessons
» Influential voices in quality management

» How to plan quality into projects
» Quality assurance and quality control



FOUNDATIONS OF AGILE PROJECT MANAGEMENT

Agile has quickly become the go-to project management approach for a wide range of industries. In this
course, you will be introduced to agile project management, including the core values and principles
outlined by the Agile Manifesto. This fast-paced, highly interactive course discusses common myths and
misconceptions about agile approaches. It identifies factors to consider when deciding whether to adopt
agile practices and explains the general agile practices that a company may want to adopt.

This workshop is desighed for anyone who wants to efficiently lead or participate in projects that experience

frequent project requirements changes.

Objectives

» Identify the key factors helping and hindering your
organization from more reliable project delivery

» Describe the values of the Agile Manifesto and why they
are important to project success

» Describe the difference between “being agile” and “doing
agile”, and why the distinction is critical

» Identify which projects are better suited for agile

approaches

 Describe how servant leadership and self-organizing teams

work on agile teams

Outline

Your Current Project Culture

» What's helping you deliver today?

 What's hindering your projects?

 How agile can help you transtorm your project culture

Agile Manifesto and Principles

« Whatis the manitesto, and why are the values so important?

ow are you already tfollowing some of the principles, and
which ones need more focus?

Creating an Agile Environment

» Whatis an agile mindset?

« How servant leadership helps agile teams succeec

» Rolesin agile teams

he difference between specialists and generalizing specialists
 Overcoming organizational silos

Delivering in an Agile Environment

» How to charter an agile project and team

» Agile practices that are common across most agile approaches
» Troubleshooting agile project challenges

» Measurements in agile projects

» Identify the common practices that span the different agile
approaches

» ldentify the roles, events, and artifacts of Scrum

» Describe why transparency, inspection, and adaptation are
critical pillars of Scrum

» Apply the learning to identify opportunities to start your
transformation to agile practices

Scrum

« Introduction to Scrum

 Scrum theory and values

» How Scrum teams work, including the roles of Scrum teams
« Scrum events and artitacts

Simulation

» Learning Scrum using a LEGO based simulation

Next Steps

» Brainstorming on the next steps to implement the learning



MAKE BETTER DECISIONS FOR YOU, YOUR TEAM AND YOUR PROJECTS

As leaders of teams and projects, we regularly face choices and decisions that have downstream
consequences. Do you want to be able to make better decisions in your personal or professional life? Do you
want to help your team members make better choices when it comes to decisions on their projects? Or are

you merely curious about how and why people make certain choices?

In this highly interactive webinar, Andy Kaufman, PMP shares why the familiar pros-and-cons approach seems to
make sense—but is profoundly flawed. He discusses how our biases influence the options we consider and the
choices we make, and how we can fight those biases. Andy shares examples of how team leaders can influence team
decisions in positive and negative ways. Is our problem with decisions that we are overconfident? Maybe— and
maybe not! Andy will show how overconfidence is overrated as an explanation for poor decisions.

Objectives

» Describe a phrase that helps identify when they are not » Describe strategies to help validate assumptions before making
evaluating enough options for their decisions decisions

« Summarize how biases impact decisions we make » Identify approaches to cut their losses on bad decisions

« Implement a 4-step process to help them make better decisions



PMI® PMP® PROFESSIONAL EXAM PREP

This learning session provides participants with the critical direction they need to take the Project Management Insti-
tute’s Project Management Professional (PMP®) certification examination. This intensive, one-day session is desighed
to get participants on the path to achieving their goal of becoming PMP certified. The session helps participants un-
derstand what they need to focus on in their preparation. Tips are provided to help them answer challenging ques-
tions, along with a top rated exam preparation book, Project Management Body of Knowledge (PMBOK), and a CD
that provides a simulated exam testing experience. (3 books total)

Outline

Topics

Module 1: Introduction: This module introduces the participants to the workshop and each other. Topics include objectives, how to get
the most out of the workshop, and participant introductions. Length: 30 minutes

Module 2: PMP Certification: This section provides a detailed overview of the certification process. Topics include the application pro-
cess, where to take the exam, information about the exam, and how to pass the exam. Length: 1 hour

Module 3: What You Need to Know: This section steps through important topics that must be understood in order to pass the
certification examination. Topics include detailed review of difficult and critical PMBOK concepts, tools, and techniques. Each of the 9
Knowledge Areas, plus Professional Responsibility, is covered. This module includes multiple passes at sample examination questions
and reviews of answers. Length: 7 hours, including lunch and breaks.

Module 4: Wrap-Up: Participants summarize key lessons learned and plan actions they will take as a result of the course. Length: 30
minutes

PROJECT MANAGEMENT SIMULATION

This one-day simulation provides a bridge from the typical classroom teaching to the application of the learning.
This learning event is a great follow-up to our project management series of classes. Whether you are preparing for
certification, looking to earn continuing education credits after certification, or want to tune-up your project

management skills, this simulation is an engaging and informative way to further develop your ability to confidently
lead and deliver.

Who Should Attend

Project managers preparing for certification. Certified project managers seeking continuing education credits (PDUs)
Professionals responsible for managing projects who want to refresh their skills.




YOU ARE A PROJECT MANAGER: LESSONS TO HELP YOU DELIVER

The business has communicated its needs. You’re excited to leap into the challenge of delivering the highest value
possible and exceeding expectations. What’s next? You have to deliver!

Regardless of the title, we are all project leaders. You’ve learned the ropes when it comes to leveraging

technology to deliver value. But how do you juggle all the risks and competing demands to deliver
successfully?

Objectives

« Describe what project management is and how it relates to your role

» Identify key factors that cause projects to fail (and succeed)

« Summarize an easy-to-remember model to guide the next steps when changes occur
 Apply a 3-step process for managing risks (so they don’t become issues)



SAFETY TRAINING

Hazard recognition emphasizes the importance of knowing
your workplace equipment and machinery to avoid any
accidents from occurring. It is the best way to prevent
accidents.

Objectives
e Bi-Lingual Training Offered
 Classroom or Virtual program

 Customize scheduling to fit your needs
« Can be delivered on-site at your facility

Outline

Safety Trainings can be customized to include some or all of the  « Forklift Safety Training Programs
below. « Hazard Communications/GHS

» 10 & 30 Hour General Industry » Jobsite Safety Audits

» 10 & 30 Hour OSHA Construction » Lead Awareness Training

» 40-Hour Hazwoper Training » Lockout/Tagout Training

» 8-Hour Refresher Training » Permit Required Confined Space
« Aerial Lilts » Personal Protective Equipment
« Bilingual Satety Training » Recordkeeping

» Bloodborne Pathogens Training » Respiratory Protection

» Develop Safety Policies and Programs » Satety Consultations

» Electrical Sarety/NFPA 70E/Arc Flash » Scaffolding Safety

» Excavation & Trenching Satety » Silica Awareness Training

» Fall Protection Training » Work-zone Satety

« Fire Protection, EAP’s & FPP’s » Written Health & Safety Programs

» First-Aid/CPR/AED
» Flagger Training



HOGAN INDEX

Currently, one of the most popular assessments on the market due to its research-based validity and unique
measuring of career risk factors. The Hogan Assessment is used in development planning for identitying
one’s strengths and development needs at a point in time.

Objectives

» Motives, Values & Preferences Inventory - internal Personality factors that describe core goals, drivers, and interests determine what
we desire and strive to attain

« Hogan Personality Inventory - the “Light Side” of Personality; shows personality factors that we use every day in our normal state of
being

« Hogan Development Survey - the “Dark Side” of Personality; shows interpersonal behaviors that emerge as career risk factors when
a person is under stress or is not actively managing how he/she comes across

KOLBE INDEX

Measures subconscious action instinct, called Conation, which predicts how you will take action on things that matter
to you. Because it’s very predictive of action, and very reliable over time (your profile does not change over the years)
it is a good tool for use in hiring and staffing, along with identifying good-fit career roles.

Objectives

» Comparing one’s own action instincts to one’s own job and to a supervisor’s view of one’s own job, for job-fit and coaching purposes

o Profiling the range of instincts on a team (Kolbe Team Synergy Report) in order to identify success strategies for working across
differences

o Identifying future career implications of one’s action instincts

» Assessing the action instincts fit for candidates in hiring situations



MYERS-BRIGGS TYPE INDICATOR

The latest version of the classic MBTI was developed and released in 2001 (the original dates to the 1940s).
The MBTI is frequently used for self-validation, career planning, and team development (relating to others
with differences from our preferences)

Objectives

» In addition to the four basic scales measuring Personality Preferences (personality types), the MBTI includes a
Step Il personality inventory. The Step Il report breaks down each preference into facets, which allows for more indepth analysis
showing the diversity of behavior

» The Team Report profiles the team’s collection of personalities and then identifies strengths and blind spots



DISC

Your individual personality affects every aspect of your life. That's why one of the best thing you do to grow yourself
and others is to understand your personality and what naturally drives you. When recognize your stregths and
weaknesses, you are able to give your best as you work with people around you.

Everyone you encounter is motivated differently, communicates differently, and views tasks and relationships
differently. This workshop will help you achieve greater success when you learn to value your strengths as well as
those of others.

Objectives

» Apply the Law of Awareness to recognize your strengths and limitations.

» Overcome your shortcomings and clear the path for personal and professional growth.

« Understand how others are different and how to work with each personality.

» Build a stronger team that communicates, appreciates the style of others and works well together.
 Learn effective strategies for handling conflict and personality clashes.

» Develop yourself and others to be their best.



ENGLISH AS A SECOND LANGUAGE (ESL)

Based on recent studies, 90% of organizationsface communication problems due to language barriers. Language
barriers can hinder productivity, collaboration, customer retention, market expansion, and even pose safety issues.
Increase your organization’s confidence andability to communicate with English as a Second Language (ESL) courses.
Our professional, industry-leading trainers are experienced in working with adult learners in the area of language

development.

Overview

 Participant assessments determine the required level of instruction

o Instructors utilize the best and latest ESL and foreign language training materials combined with your company’s
documents to create a customized curriculum for your workers’ needs

» Instructors perform a thorough needs analysis and round table discussion with your company’s managers and
supervisors prior to launching any language program. All potential students’ skills will need to be evaluated
before recommendations can be given

» Can be scheduled Virtually or On-Site in a Classroom setting depending on your schedule

 Five Instruction Levels ranging from pre-literate up to advanced focusing on workplace and daily life topics
and grammatical structure

» Customized Advanced ESL programs for verbal communication, pronunciation, business writing, presentation,
and cross-cultural skills for non-native business professionals

 Basic Skills classes including mathematics, literacy, basic computer skills, GED, test-taking, etc.

« Command Spanish, designed for those who supervise Spanish-speakers in the workplace

» Foreign Language courses in any language with emphasis on workforce and business travel applications
(Japanese, Italian, German, French, Chinese, etc.)



